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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the MG3700A Vector Signal Generator 
Operation Manual (Mainframe), or MG3710A/MG3710E 
Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe). Please also 
refer to them before using the equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the following 
safety symbols to indicate safety-related information. Ensure that you clearly understand the meanings of the 
symbols BEFORE using the equipment. Some or all of the following symbols may be used on all Anritsu equipment. 
In addition, there may be other labels attached to products that are not shown in the diagrams in this manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 
This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 
 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions. Ensure that you clearly understand the meanings of the symbols and 
take the necessary precautions BEFORE using the equipment. 
 
  This indicates a prohibited operation. The prohibited operation is indicated 

symbolically in or near the barred circle. 
 
  This indicates an obligatory safety precaution. The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution. The contents are indicated symbolically in or 

near the triangle. 

 
  This indicates a note. The contents are described in the box. 
 
 
 
  These indicate that the marked part should be recycled. 
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All rights reserved. No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The operational instructions of this manual may be changed without prior notice. 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
● During the warranty period, Anritsu Corporation will repair or exchange 

this software free-of-charge if it proves defective when used as described 
in the operation manual. 

● The warranty period is 6 months from the purchase date. 
● The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

● This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for damage or financial loss of 
the customer due to the use of or a failure to use this equipment, unless the 
damage or loss is caused due to Anritsu Corporation’s intentional or gross 
negligence. 
 
 

Anritsu Corporation Contact 
In the event of this equipment malfunctions, please contact an Anritsu 
Service and Sales office. Contact information can be found on the last page 
of the printed version of this manual, and is available in a separate file on the 
PDF version. 
 



 

iv 

 

 
 

Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 
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Software End-User License Agreement (EULA) 
Please carefully read and accept this Software End-User License Agreement (hereafter this EULA) 
before using (includes executing, copying, installing, registering, etc.) this Software (includes programs, 
databases, scenarios, etc., used to operate, set, etc., Anritsu electronic equipment, etc.). By using this 
Software, you shall be deemed to have agreed to be bound by the terms of this EULA, and Anritsu 
Corporation (hereafter Anritsu) hereby grants you the right to use this Software with the Anritsu 
specified equipment (hereafter Equipment) for the purposes set out in this EULA. 
 
Article 1. Grant of License and Limitations 

1. You may not sell, transfer, rent, lease, lend, 
disclose, sublicense, or otherwise distribute 
this Software to third parties, whether or not 
paid therefor. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer, 
disassemble, decompile, modify or create 
derivative works of this Software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

Article 2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for direct, or 
any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, and damages claimed by 
third parties, arising out of or related to your 
use or inability to use this Software, unless 
the damages are caused due to Anritsu’s 
intentional or gross negligence. 

Article 3. Limitation of Liability 
1. If a fault (bug) is discovered in this Software,  

making this Software unable to operate as 
described in the operation manual or 
specifications even though you have used 
this Software as described in the manual, 
Anritsu shall at its own discretion, fix the 
bug, or replace the software, or suggest a 
workaround, free-of-charge, provided, 
however, that the faults caused by the 

following items and any of your lost or 
damaged data whatsoever shall be excluded 
from repair and the warranty. 

i) If this Software is deemed to be used 
for purposes not described in the 
operation manual or specifications. 

ii) If this Software has been used in 
conjunction with other 
non-Anritsu-approved software. 

iii) If this Software or the Equipment has 
been modified, repaired, or otherwise 
altered without Anritsu's prior 
approval. 

iv) For any other reasons out of Anritsu's 
direct control and responsibility, such 
as but not limited to, natural disasters, 
software virus infections, or any 
devices other than this Equipment, etc. 

2. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs or 
replacement by Anritsu engineers 
necessitated by the above faults shall be 
borne by you. 

3. The warranty period for faults listed in 
Section 1 of this Article shall be either 6 
months from the date of purchase of this 
Software or 30 days after the date of repair 
or replacement, whichever is longer. 
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Article 4. Export Restrictions 
 You shall not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by the laws and 
regulations of Japan and the United States, 
etc. In particular, this Software shall not be 
exported or re-exported (a) into any Japan or 
US embargoed countries or (b) to anyone 
restricted by the Japanese export control 
regulations, or the US Treasury 
Department's list of Specially Designated 
Nationals or the US Department of 
Commerce Denied Persons List or Entity 
List. In using this Software, you warrant 
that you are not located in any such 
embargoed countries or on any such lists. 
You also agree that you will not use or 
otherwise export or re-export this Software 
for any purposes prohibited by the Japanese 
and US laws and regulations, including, 
without limitation, the development, design 
and manufacture or production of missiles or 
nuclear, chemical or biological weapons of 
mass destruction, and conventional 
weapons. 

Article 5. Change of Terms 
 Anritsu may change without your approval 

the terms of this EULA if the changes are for 
the benefit of general customers, or are 
reasonable in light of the purpose of this 
EULA and circumstances of the changes. At 
the time of change, Anritsu will inform you 
of those changes and its effective date, as a 
general rule 45 days, in advance on its 
website, or in writing or by e-mail. 

Article 6. Termination 
1. Anritsu may terminate this EULA 

immediately if you violate any conditions 
described herein. This EULA shall also be 
terminated immediately by Anritsu if there 
is any good reason that it is deemed difficult 
to continue this EULA, such as your 
violation of Anritsu copyrights, patents, etc. 
or any laws and ordinances, or if it turns out 

that you belong to an antisocial organization 
or has a socially inappropriate relationship 
with members of such organization. 

2. You and Anritsu may terminate this EULA 
by a written notice to the other party 30 
days in advance. 

Article 7. Damages 
 If Anritsu suffers any damages or loss, 

financial or otherwise, due to your violation 
of the terms of this EULA, Anritsu shall 
have the right to seek proportional damages 
from you. 

Article 8. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with Article 6, you shall cease all 
uses of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

Article 9. Negotiation for Dispute 
Resolution 

 If matters of interpretational dispute or 
items not covered under this EULA arise, 
they shall be resolved by negotiations in 
good faith between you and Anritsu. 

Article 10. Governing Law and Court of 
Jurisdiction 

 This EULA shall be governed by and 
interpreted in accordance with the laws of 
Japan without regard to the principles of the 
conflict of laws thereof, and any disputes 
arising from or in relation to this EULA that 
cannot be resolved by negotiation described 
in Article 9 shall be subject to and be settled 
by the exclusive agreed jurisdiction of the 
Tokyo District Court of Japan. 

 
Revision History: 

February 29th, 2020 
December 17th, 2021 
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Cautions Against Computer Virus Infection 
● Copying files and data 

Only files that have been provided directly from Anritsu or generated 
using Anritsu equipment should be copied to the instrument. 
All other required files should be transferred by means of USB flash 
drive or CompactFlash media after undergoing a thorough virus 
check. 

● Adding software 
Do not download or install software that has not been specifically 
recommended or licensed by Anritsu.  

● Network connections 
Ensure that the network has sufficient anti-virus security protection in 
place. 

● Protection against malware (malicious software such as viruses). 
This equipment runs on Windows Operating System. 
To connect this equipment to network, the following is advised.  

- Activate Firewall. 
- Install important updates of Windows.  
- Use antivirus software. 

 
 

 



 

viii 

 

 

 
 

Protection Against Computer Virus Infections 
Prior to the software installation 

 Before installing this software or any other software recommended or 
approved by Anritsu, run a virus scan on your computer, including 
removable media (e.g. USB flash drive and CF memory card) you 
want to connect to your computer. 

 
When using this software and connecting with the measuring instrument 
● Copying files and data 

On your computer, do not save any copies other than the following: 
- Files and data provided by Anritsu 
- Files created by this software 
- Files specified in this document 
Before copying these files and/or data, run a virus scan, including 
removable media (e.g. USB flash drive and CF memory card). 

● Connecting to network 
Connect your computer to the network that provides adequate 
protection against computer viruses. 

● Protection against malware (malicious software such as viruses). 
To connect your computer to network, the following is advised.  

- Activate Firewall. 
- Install important updates of Windows.  
- Use antivirus software. 

 
 

Cautions on Proper Operation of Software 
This software may not operate normally if any of the following operations 
are performed on your computer: 
● Simultaneously running any software other than that recommended 

or approved by Anritsu 
● Closing the lid (Laptop computer) 
● Turning on the screen saver function 
● Turning on the battery-power saving function (Laptop computer) 
For how to turn off the functions, refer to the operation manual that came 
with your computer. 
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About This Manual 
 Associated Documents 
The operation manual configuration of the MX370107A Fading IQpro-
ducer™ is shown below.  

 If using MG3700A, MG3710A, MG3710E or MG3740A:  

Or 

 

MX370107A 
Fading IQproducer™ Operation Manual  

MG3700A /MG3710A/MG3710E Vector Signal Generator  
MG3740A Analog Signal Generator Operation Manual (IQproducer™) 

MG3700A  
Vector Signal Generator  
Operation Manual (Mainframe) 

MG3710A/MG3710E Vector Signal Generator 
MG3740A Analog Signal Generator  
Operation Manual (Mainframe) 

 
 MG3700A Vector Signal Generator Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3700A Vector Signal Generator.  

 Or 

 MG3710A/MG3710E Vector Signal Generator MG3740A Analog Signal 

Generator Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3710A/MG3710E Vector Signal Generator and the 
MG3740A Analog Signal Generator.  

 

 MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A Ana-

log Signal Generator Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator and the Analog Signal 
Generator. 
 

 Fading IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of the Fading IQproduc-
erTM.  

 

Name Used in This Manual 
In this manual, it is assumed that you use MG3710A unless otherwise 
noted. If you use MG3710E, read MG3710A as MG3710E.  
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This chapter provides an overview of the MX370107A Fading 
IQproducer™. 

 

1.1 Product overview ....................................................... 1-2 
1.2 Product Composition ................................................. 1-5 
 

 



 
Chapter 1  Overview 

1-2 

1.1 Product overview 
MX370107A Fading IQproducer™ (hereinafter referred to as “this 
software”) is software used to read waveform patterns and generate 
fading-processed waveform patterns. 

This software requires either of the following environment: 

• MG3710A Vector Signal Generator 

• MG3740A Analog Signal Generator 

• Personal computer (hereinafter, “PC”) 
 
This software generates waveform patterns that support the 
specifications of fading with various characteristics. This is made 
possible by the editing/customizing of parameters according to its use.  

A waveform pattern created by this software can be output using an RF 
signal after being downloaded into the MG3700A Vector Signal Generator, 
MG3710A Vector Signal Generator or MG3740A Analog Signal Generator 
(collectively referred to as “mainframe”, or “this equipment”). 

With the MX370107A, fading processing of each channel, correlation 
matrix calculation, and AWGN addition can be performed as shown in 
the dotted rectangle in the operation flow of Fig. 1.1-1.  ASCII format 
files created using simulation software in addition to waveform pattern 
files created using IQproducer™ can be specified for IQ data files to be 
input.  

This software can also simulate the propagation environment between 
transmission and reception antennas.  A configuration example when 
using a 2  2 MIMO configuration with this software is shown in Fig. 
1.1-2.  In this example, this software performs fading processing for the 
waveform pattern files that correspond to the signals transmitted from 
each of the transmission antennas, and outputs the fading-processed 
waveform pattern files from two MG3700A/MG3710A/MG3740A units, 
simulating the propagation environment between transmission and 
reception antennas in 2  2 MIMO.  Refer to Chapter 3 “Detailed 
Description of Functions” for details on this software, and refer to 
Appendix C “Connecting Multiple MG3700A/10A/40A Units” for how to 
synchronize two or more MG3700A/MG3710A/MG3740A units. 
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IQ data for each Tx antenna 

AWGN calculation 

Fading processing of 
each channel 

Processing executed by 
MX370107A 

MG3700A/MG3710A/MG3740A 
Vector Signal Generator 

IQproducer™,  
Simulation Software 

MG3700A/MG3710A/MG3740A 

 waveform pattern file 

IQ data for each Rx antenna 

 

Fig. 1.1-1  Fading processing flow 

 



 

Chapter 1  Overview 

1-4 

 

Transmitter 

Tx Antenna 1 Tx Antenna 2 

Receiver 

Rx Antenna 1 Rx Antenna 2 
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Rx Antenna 1 Rx Antenna 2 

IQ data for 
Tx Antenna 1 

IQ data for 
Tx Antenna 2 

IQ data for 
Rx Antenna 1 
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Rx Antenna 2 
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MG3740A#1 

MG3700A/MG3710A/ 
MG3740A#2 

Fading IQproducerTM 

Fading Environment 

IQproducer™,  

Simulation Software 

 SG Primary/Secondary Setting：

 

Fig. 1.1-2  2  2 MIMO configuration example 
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1.2 Product Composition 
The following table lists the model name and specifications of this 
software according to the equipment. 

Table 1.2-1  Restrictions 

Mainframe 

 

Restrictions 

MG3700A MG3710A MG3740A 

Software name MX370107A 

Maximum Size 
of Waveform 
Patterns 

256 M sample 
512 M 
sample*1 

64 M sample 
128 M sample*3 
256 M sample*4 
512 M sample*5 

1024 M sample*6 

64 M sample 
128 M sample*3 
256 M sample*4 
512 M sample*5 

 

Transmission 
method of 
Waveform 
Patterns 

LAN, 
CompactFlas
h Card 

External 
device such as 
LAN,  
USB flash 
drive*2 

External 
device such as 
LAN,  
USB flash 
drive*2 

Installation of 
this software 
to this 
equipment 

N/A Possible  Possible  

 

*1: The ARB memory expansion 512M sample (optional) must be 
installed into the MG3700A to use waveform patterns that exceed 
256 M samples. 

*2: Transferring waveform patterns is not required if the waveform 
patterns are created on the equipment using this software. 

*3: The Combination of Baseband Signal (optional) must be installed 
into the MG3710A/MG3740A to use waveform patterns of maximum 
128 M samples. 

*4: The ARB memory expansion 256M sample (optional) must be 
installed into the MG3710A/MG3740A to use waveform patterns of 
maximum 256 M samples.  
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*5: To use waveform patterns of maximum 512 M samples, either of the 
following must be installed: 

MG3710A 

 ARB memory expansion 1024 M sample (optional) 

 ARB memory expansion 256 M (optional) and Combination of 
Baseband Signal (optional) 

MG3740A 

 ARB memory expansion 256 M (optional) and Combination of 
Baseband Signal (optional) 

*6: The ARB memory expansion 1024M sample (optional) must be 
installed into the MG3710A to use waveform patterns of maximum 
1024 M samples. 

 Notes on waveform pattern conversion 

The waveform patterns generated with this software varies according to 
the main unit type. If using the waveform pattern to the different main 
unit, you need to convert the waveform pattern.  

For details about how to convert a waveform pattern, see Section 4.5 
“File Conversion on Convert Screen” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™). 
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Preparation 

This chapter describes the operating environment for this software. 

 

2.1 Operating Environment ............................................ 2-2 
2.2 Installation/Uninstallation.......................................... 2-3 
2.3 Starting up and exiting the software.......................... 2-4 

2.3.1 Starting Software: When installed on PC ...... 2-4 
2.3.3 Starting Software: When installed on  

MG3710A .................................................... 2-7 
2.3.4 Exiting Software ........................................... 2-9 
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2.1 Operating Environment 
The following environment is required for operating this software. 

(1) PC that meets the following conditions 

OS Windows XP/Windows Vista/Windows 7 
CPU Pentium III 1 GHz equivalent or faster 
Memory 512 MB or more 

Hard disk space 

5 GB or more free space in the drive where 
this software is to be installed.  
The free hard disk space necessary to create 
waveform pattern varies depending on the 
waveform pattern size. The free disk space of 
27 GB or greater is required to create four 
maximum (512 Msample) waveform patterns. 

 
(2) If viewing on PC, displays with a resolution of 1024 × 768 pixels are 

best viewed using a small font setting. 
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2.2 Installation/Uninstallation 
This software is included in the IQproducer™ installer. It is 
automatically installed by installing the IQproducer™ that is supplied 
with this equipment or this software. When using a waveform pattern 
created using this software in the equipment, the license file must be 
installed in advance. 

 Installing/Uninstalling IQproducer™ 
Refer to section 2 “Installation/Uninstallation” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™). 

 Installing/Uninstalling IQproducer™ license file 
For how to install license file to MG3700A/MG3710A, refer to the 
following manual:  

• MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™) 
5.1 “Installing License File” 
 

For how to uninstall license file from MG3700A/MG3710A, refer to each 
one of the following manuals:  

• MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.10.10 “Install” 

• MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 
9.4.4 “Install” 
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2.3 Starting up and exiting the software 
This section explains how to start and stop this software. 

Note: 
The following explanation assumes the use of Windows XP. The 
screen image may differ slightly if not using Windows XP.  

 

2.3.1 Starting Software: When installed on PC 
Start this software using the following procedure.  
The example assumes that it is a PC operation.  

<Procedure> 
1. Click Start on the task bar, and point to All Programs. Next, point to 

Anritsu Corporation, point to IQproducer, and then click 
IQproducer. 

 

Figure 2.3.1-1  Program selection screen  
 

2. When IQproducer™ starts, the Select instrument screen is 
displayed. 

This Select instrument screen is used to select either MG3700A, 
MG3710A or MG3740A. This following explanation assumes that 
you have selected MG3700.  
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Figure 2.3.1-2  Select Instrument Screen 

 
Notes: 

1. This software does not support MS269xA and MS2830A. 

2. To hide this screen and to start with the selected mainframe's 
screen from the next time, select the Don't show this window 
next time check box. 

3. The common platform screen is displayed when OK is clicked in the 
Select instrument screen.  
The common platform screen is a screen used to select each function 
of the IQproducer™.  

 
Figure 2.3.1-3  Common Platform Screen 

 

4. Click the General Purpose tab on the common platform screen, to 
show the General Purpose selection screen that supports each 
telecommunication system.  
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Figure 2.3.1-4  General Purpose Selection Screen 

 

5. Click Fading to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  

Note: 
If Change Instrument is clicked, the Select instrument screen will 
appear each time the software is loaded.  
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2.3.2 Starting Software: When installed on MG3710A/MG3740A 
Start this software using the following procedure.  
<Procedure> 
1. Press  on the MG3710A/MG3740A front panel to display the 

common platform screen.  
Note:  

The common platform screen does not appear when pressing 
 if Option 020/120 are not installed in the MG3740A. 

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 
Figure 2.3.2-1  Common Platform Screen 

 

2. Click the General Purpose tab on the common platform screen, to 
show the General Purpose selection screen that supports each 
telecommunication system.  

 
Figure 2.3.2-2  General Purpose Selection Screen 
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3. Click Fading to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  

Note: 
When this software is installed on MG3710A/MG3740A, Change 
Instrument displays instead of Interface Settings. Clicking 
Interface Settings displays the Interface Setting dialog box. 

 

Figure 2.3.2-3  Interface Settings Dialog Box 
 

Here, you can configure interface-related settings of IQproducer 
and MG3710A/MG3740A. To return to factory defaults, click 
Default. 

• Row Socket Port Number 
Sets Row Socket port number. Set the same value as that for 
MG3710A/MG3740A.  

• Wait Time 
Sets the wait time between commands.  
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2.3.3 Exiting Software 
Stop this software using the following procedure. 

 When exiting only this software 
To exit only this software without closing the Common Platform screen, 
or other IQproducer™ tools, do one of these below: 

• Click the Exit button ( ) on the tool bar. 
• Select Exit from the File menu. 
• Click the  button on the upper right screen. 
 

 
Figure 2.3.3-1  Exiting Software 

 

The operation of the three screen buttons is explained below.  

 
Figure 2.3.3-2  Exit Confirmation Window 

 

• Yes Saves current parameters to file and stops this 
software. 

• No Stops this software without saving current 
parameters to file. 

• Cancel or  Cancels the process and returns to the main screen. 
 
When stopping this software using the Yes button, the saved parameters 
are read at the next start and reset for each parameter.  

 When exiting entire IQproducer™ application 
To exit all tools of IQproducer™ that are running, select Exit on the 
Common Platform Screen. In this case, a dialog is displayed to confirm 
stopping of each running tool.  
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Figure 2.3.3-3  Exiting IQproducer™ 
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This chapter provides detailed descriptions of this software. 

Notes: 

 The examples and screens used throughout this chapter are 
based on the assumption that the IQproducer™ is activated 
with the MG3700A.  

 The MG3710A, MG3740A functions are described as notes in 
each item. 
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3.1 Screen Details 
3.1.1 Main screen 

On common platform screen, select the General Purpose tab, and then 
select Fading to display the main screen. 

Figure 3.1.1-1 shows the main screen of this software. The main screen 
consists of the menu, toolbar, Common tab window, Channel tab window, 
Birth-Death Propagation tab window, Moving Propagation tab window, 
and High Speed Train tab window. The number and type of tabs to be 
displayed differ depending on the settings on the Common tab window. 
For details on each of the tab windows, refer to the corresponding 
sections. 

 SG Primary/Secondary Setting：

Menu 

Toolbar 

Channel setting tab 

Tx Antenna Configuration 
field 

Common setting tab 

System Configuration 
field 

Rx Antenna Configuration 
field 

Channel Setting field 

 

Figure 3.1.1-1  Main screen 
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Screen transition 
Figure 3.1.1-2 shows screen transition of this software. For details on 
each of the screens, refer to the sections shown below the corresponding 
screen. 

 

Calculation 
button 

[Cancel] 
button 

[OK] button 

Calculation completed: [OK] button 
During calculation: [Cancel] button 

Input file specified 

[OK]/[Cancel] button 

Calculation screen 
(Refer to Section 3.1.8 
“Calculation window.”) 

Export File window 
(Refer to 3.1.7 “Export File window.”) 

Read confirmation screen 
(Refer to Section 3.1.2 
“Common setting tab window.”) 

Main screen 
(Refer to Section 3.1.1 “Main screen.”) 

 SG Primary/Secondary Setting：

 

Figure 3.1.1-2  Overview of screen transition 
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 The [File] menu contains the following items. 

 

Figure 3.1.1-3  Screen when File is selected 

 

 Select Option 

■ When using MG3700A 

 Select whether the ARB memory expansion option 
256Msamples is installed. Selecting With Option21 (Memory 
512M samples) supports creation of larger waveform patterns. 
If the ARB memory expansion option is not installed, the 
generated waveform pattern may not be able to be used. 
Waveform patterns cannot be created with a size greater than 
256Msamples or when Without Option21 (Memory 512M 
samples) is selected. Select either according to the presence of 
ARB memory expansion option. 

Table 3.1.1-1  Available Options for MG3700A  

Items ARB Memory Expansion 

With Option21 (Memory 512M 
samples) 1 GB x 2 memory 

Without Option21 (Memory 
512M samples): 512 MB × 2 Memories 

  

■ When using MG3710A or MG3740A 

 The presence/absence of the ARB Memory Expansion (option) 
and Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the 
Baseband Signal Combination Function (option) generates a 
bigger waveform pattern, while selecting the Baseband Signal 
Combination Function (option) generates a waveform pattern. If 
an uninstalled option is selected, sometimes the created 
waveform pattern may not be usable.  

 Set the combination of installed options based on the following 
setting items.   
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Table 3.1.1-2  Available Options for MG3710A or MG3740A 

Items Combinations of Options 

Memory 64M samples None 
Memory 64M samples × 2 Option48 and Option 78 
Memory 256M samples Option45 or Option 75 

Memory 256M samples × 2 
Option 45 and Option 48 
or 
Option 75 and Option 78 

Memory 1024M samples* 
Option46 
or 
Option 76 

Memory 1024M samples × 2* 
Option 46 and Option 48 
or 
Option 76 and Option 78 

 
*: Option 46 and Option 76 are not available for MG3740A and do not 

appear on the display. 

 
The maximum size of the generated waveform pattern for each 
of the setting items is shown below.  

Table 3.1.1-3  Waveform Pattern Maximum Size 

Items Maximum Size 

Memory 64M samples 64M samples 
Memory 64M samples × 2 
 (With Option48, 78) 128M samples 

Memory 256M samples 256M samples 
Memory 256M samples × 2 
 (With Option48, 78) 512M samples 

Memory 1024M samples* 1024M samples 
Memory 1024M samples × 2* 
 (With Option48, 78) 1024M samples 

 

*: Does not support MG3740A. 

 

 Recall Parameter File 
Loads the parameter files saved by the [Save Parameter File] menu. 
When the parameter file is loaded, the settings when it was loaded 
are recovered. 

 

 Save Parameter File 
Saves the current setting parameters to a file. 

 

 Exit 
Exits from this software. 
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 The [Edit] menu contains the following items. 

 

Figure 3.1.1-4  Screen when Edit is selected 

 

 Calculation 

Generates a waveform pattern. 

 

 Calculation & Load  

Note: 

This function is available only when this software is used on 
MG3710A or MG3740A. 

After waveform generation is finished, the created waveform 
pattern is loaded into the MG3710A or MG3740A waveform 
memory.  

 

 Calculation & Play  

Note: 

This function is available only when this software is used on 
MG3710A or MG3740A. 

After waveform generation is finished, the created waveform 
pattern is loaded and selected at the MG3710A or MG3740A 
waveform memory.  

 

 Copy Channel 1 To All 

Copies the Channel 1 settings to all other channels. 

 

 Clipping 

Displays the Clipping screen. In this screen, the generated 
waveform patterns can be clipped and filtered. 
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 The [Transfer Setting] menu contains the following item. 

 

Figure 3.1.1-5  Screen when Transfer Setting is selected 

 

 Transfer Setting Wizard 

Displays the Transfer Setting Wizard screen. In this screen, a series 
of operations including connection between PC and the 
MG3700A/MG3710A/MG3740A, waveform pattern transfer to the 
MG3700A/MG3710A/MG3740A internal hard disk, and waveform 
pattern loading from the hard disk to an arbitrary waveform 
memory are performed. 

 

 The [Simulation] menu contains the following items. 

 

Figure 3.1.1-6  Screen when Simulation is selected 

 

 CCDF 

Displays the CCDF Graph Monitor screen. In this screen, the CCDF 
of the generated waveform pattern is displayed in a graph. 

 

 FFT 

Displays the FFT Graph Monitor screen. In this screen, the 
FFT-processed spectrum of the generated waveform pattern is 
displayed in a graph. 
 

 Time Domain 

Displays the Time Domain Graph Monitor screen. In this screen, the 
time-domain waveform of the generated waveform pattern is 
displayed in a graph. 
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 The Tool buttons contains the following items. 

Note: 

Calculation & Load and Calculation & Play are available 
only when this software is used on MG3710A or MG3740A. 

 

  Recall Parameter File 

  Save Parameter File 

  Calculation 

  Calculation & Load 

  Calculation & Play 

 Transfer & Setting Wizard 

  CCDF 

  FFT 

  Time Domain 

 Clipping 

  Exit 

 

Clicking a tool button operates the same as the corresponding 
commands in the menu.  
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3.1.2 Common tab window 
The Common tab window is shown in Figure 3.1.2-1. The Common tab 
window consists of the System Configuration, Tx Antenna Configuration, 
Channel Setting, and Rx Antenna Configuration fields. 

 

 SG Primary/Secondary Setting：

Tx Antenna Configuration 
field 

System Configuration field 

Rx Antenna Configuration 
field 

Channel Setting field 

 

Figure 3.1.2-1  Common tab window 



 

Chapter 3  Detailed Description of Functions 

3-10 

3.1.2.1 Tab configuration 

The tabs to be displayed differ depending on the Channel Configuration 
and Fading Profile settings on the Common tab window. Table 3.1.2.1-1 
shows the correspondence between the Channel Configuration and 
Fading Profile settings and the tabs to be displayed. 

Table 3.1.2.1-1  Settings on Common tab window and displayed tabs 

Channel Configuration Fading Profile Tab Displayed 

1  1 SISO 

Moving Propagation Moving Propagation setting tab 
Birth-Death Propagation Birth-Death Propagation setting tab 
High Speed Train High Speed Train setting tab 
Other than the above Channel 1 setting tab 

1  2 SIMO Arbitrary Channel 1 and Channel 2 setting tabs 
1  3 SIMO Arbitrary Channel 1 to Channel 3 setting tabs 
1  4 SIMO Arbitrary Channel 1 to Channel 4 setting tabs 
2  1 MISO Arbitrary Channel 1 and Channel 2 setting tabs 
2  2 MIMO Arbitrary Channel 1 to Channel 4 setting tabs 
2  3 MIMO Arbitrary Channel 1 to Channel 6 setting tabs 
2  4 MIMO Arbitrary Channel 1 to Channel 8 setting tabs 
3  1 MISO Arbitrary Channel 1 to Channel 3 setting tabs 
3  2 MIMO Arbitrary Channel 1 to Channel 6 setting tabs 
3  3 MIMO Arbitrary Channel 1 to Channel 9 setting tabs 
3  4 MIMO Arbitrary Channel 1 to Channel 12 setting tabs 
4  1 MISO Arbitrary Channel 1 to Channel 4 setting tabs 
4  2 MIMO Arbitrary Channel 1 to Channel 8 setting tabs 
4  3 MIMO Arbitrary Channel 1 to Channel 12 setting tabs 
4  4 MIMO Arbitrary Channel 1 to Channel 16 setting tabs 
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The number of tabs displayed in the Tx Antenna Configuration and Rx 
Antenna Configuration fields also changes depending on the Channel 
Configuration setting. Table 3.1.2.1-2 shows the correspondence between 
the Channel Configuration setting and the tabs to be displayed in the Tx 
Antenna Configuration and Rx Antenna Configuration fields. 

Table 3.1.2.1-2  Tabs displayed in Tx Antenna Configuration and Rx Antenna Configuration fields 

Channel Configuration Tx Antenna Configuration Rx Antenna Configuration 

1  1 SISO Tx Antenna 1 Rx Antenna 1 
1  2 SIMO Tx Antenna 1 Rx Antenna 1 and Rx Antenna 2 
1  3 SIMO Tx Antenna 1 Rx Antenna 1 to Rx Antenna 3 
1  4 SIMO Tx Antenna 1 Rx Antenna 1 to Rx Antenna 4 
2  1 MISO Tx Antenna 1 and Tx Antenna 2 Rx Antenna 1 
2  2 MIMO Tx Antenna 1 and Tx Antenna 2 Rx Antenna 1 and Rx Antenna 2 
2  3 MIMO Tx Antenna 1 and Tx Antenna 2 Rx Antenna 1 to Rx Antenna 3 
2  4 MIMO Tx Antenna 1 and Tx Antenna 2 Rx Antenna 1 to Rx Antenna 4 
3  1 MIMO Tx Antenna 1 to Tx Antenna 3 Rx Antenna 1 
3  2 MIMO Tx Antenna 1 to Tx Antenna 3 Rx Antenna 1 and Rx Antenna 2 
3  3 MIMO Tx Antenna 1 to Tx Antenna 3 Rx Antenna 1 to Rx Antenna 3 
3  4 MIMO Tx Antenna 1 to Tx Antenna 3 Rx Antenna 1 to Rx Antenna 4 
4  1 MISO Tx Antenna 1 to Tx Antenna 4 Rx Antenna 1 
4  2 MIMO Tx Antenna 1 to Tx Antenna 4 Rx Antenna 1 and Rx Antenna 2 
4  3 MIMO Tx Antenna 1 to Tx Antenna 4 Rx Antenna 1 to Rx Antenna 3 
4  4 MIMO Tx Antenna 1 to Tx Antenna 4 Rx Antenna 1 to Rx Antenna 4 
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3.1.2.2 Common parameters 

This section describes the parameters provided in the Common tab 
window. 

System Configuration field 

Channel Configuration 

[Overview] Sets the number of I/O antennas. 

[Default] 1  1 SISO 

[Setting range] 1  1 SISO, 1  2 SIMO, 1  3 SIMO, 1  4 SIMO,  
2  1 MISO, 2  2 MIMO, 2  3 MIMO, 2  4 MIMO,  
3  1 MISO, 3  2 MIMO, 3  3 MIMO, 3  4 MIMO,  
4  1 MISO, 4  2 MIMO, 4  3 MIMO, 4  4 MIMO 

Channel configurations 1  1 SISO to 4  4 MIMO can be selected in 
Channel Configuration. Each channel configuration is described below. 

(1  1 SISO) 
Communication is performed using a single antenna at each of the 
transmission and reception stations in this configuration. 
Figure 3.1.2.2-1 is displayed when 1  1 SISO is selected in Channel 
Configuration. 

 

 

Figure 3.1.2.2-1  1  1 SISO configuration 

 

(1  2 SIMO) 
Communication is performed using a single antenna at the transmission 
station and two antennas at the reception station in this configuration. 
Figure 3.1.2.2-2 is displayed when 1  2 SIMO is selected in Channel 
Configuration. In this case, two waveform patterns corresponding to the 
two Rx antenna modulation signals are generated. 

 

 

Figure 3.1.2.2-2  1  2 SIMO configuration 
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(1  3 SIMO) 
Communication is performed using a single antenna at the transmission 
station and three antennas at the reception station in this configuration. 
Figure 3.1.2.2-3 is displayed when 1  3 SIMO is selected in Channel 
Configuration. In this case, three waveform patterns corresponding to 
the three Rx antenna modulation signals are generated. 

 

Figure 3.1.2.2-3  1  3 SIMO configuration 

 

(1  4 SIMO) 
Communication is performed using a single antenna at the transmission 
station and four antennas at the reception station in this configuration. 
Figure 3.1.2.2-4 is displayed when 1  4 SIMO is selected in Channel 
Configuration. In this case, four waveform patterns corresponding to the 
four Rx antenna modulation signals are generated. 

 

Figure 3.1.2.2-4  1  4 SIMO configuration 

 



 

Chapter 3  Detailed Description of Functions 

3-14 

(2  1 MISO) 
Communication is performed using two antennas at the transmission 
station and a single antenna at the reception station in this configuration. 
Figure 3.1.2.2-5 is displayed when 2  1 MISO is selected in Channel 
Configuration. 

 

 

Figure 3.1.2.2-5  2  1 MISO configuration 

 

(2  2 MIMO) 
Communication is performed using two antennas at each of the 
transmission and reception stations in this configuration. 
Figure 3.1.2.2-6 is displayed when 2  2 MIMO is selected in Channel 
Configuration. In this case, two waveform patterns corresponding to the 
two Rx antenna modulation signals are generated. 

 

 

Figure 3.1.2.2-6  2  2 MIMO configuration  

 

(2  3 MIMO) 
Communication is performed using two antennas at the transmission 
station and three antennas at the reception station in this configuration. 
Figure 3.1.2.2-7 is displayed when 2  3 MIMO is selected in Channel 
Configuration. In this case, three waveform patterns corresponding to 
the three Rx antenna modulation signals are generated.  

 

 

Figure 3.1.2.2-7  2  3 MIMO configuration 
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(2  4 MIMO) 
Communication is performed using two antennas at the transmission 
station and four antennas at the reception station in this configuration. 
Figure 3.1.2.2-8 is displayed when 2  4 MIMO is selected in Channel 
Configuration. In this case, four waveform patterns corresponding to the 
four Rx antenna modulation signals are generated. 

 

 

Figure 3.1.2.2-8  2  4 MIMO configuration 

 

(3  1 MISO) 
Communication is performed using three antennas at the transmission 
station and a single antenna at the reception station in this configuration. 
Figure 3.1.2.2-9 is displayed when 3  1 MISO is selected in Channel 
Configuration.  

 

 

Figure 3.1.2.2-9  3  1 MISO configuration 
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(3  2 MIMO) 
Communication is performed using three antennas at the transmission 
station and two antennas at the reception station in this configuration. 
Figure 3.1.2.2-10 is displayed when 3  2 MIMO is selected in Channel 
Configuration. In this case, two waveform patterns corresponding to the 
two Rx antenna modulation signals are generated.  

 

 

Figure 3.1.2.2-10  3  2 MIMO configuration 

 

(3  3 MIMO) 
Communication is performed using three antennas at each of the 
transmission and reception stations in this configuration. 
Figure 3.1.2.2-11 is displayed when 3  3 MIMO is selected in Channel 
Configuration. In this case, three waveform patterns corresponding to 
the three Rx antenna modulation signals are generated.  

 

 

Figure 3.1.2.2-11  3  3 MIMO configuration 
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(3  4 MIMO) 
Communication is performed using three antennas at the transmission 
station and four antennas at the reception station in this configuration. 
Figure 3.1.2.2-12 is displayed when 3  4 MIMO is selected in Channel 
Configuration. In this case, four waveform patterns corresponding to the 
four Rx antenna modulation signals are generated.  

 

 

Figure 3.1.2.2-12  3  4 MIMO configuration 

 

(4  1 MISO) 
Communication is performed using four antennas at the transmission 
station and a single antenna at the reception station in this configuration. 
Figure 3.1.2.2-13 is displayed when 4  1 MISO is selected in Channel 
Configuration. 

 

 

Figure 3.1.2.2-13  4  1 MISO configuration 
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(4  2 MIMO) 
Communication is performed using four antennas at the transmission 
station and two antennas at the reception station in this configuration. 
Figure 3.1.2.2-14 is displayed when 4  2 MIMO is selected in Channel 
Configuration. In this case, two waveform patterns corresponding to the 
two Rx antenna modulation signals are generated.  

 

Figure 3.1.2.2-14  4  2 MIMO configuration 

 

(4  3 MIMO) 
Communication is performed using four antennas at the transmission 
station and three antennas at the reception station in this configuration. 
Figure 3.1.2.2-15 is displayed when 4  3 MIMO is selected in Channel 
Configuration. In this case, three waveform patterns corresponding to 
the three Rx antenna modulation signals are generated. 

 

 

Figure 3.1.2.2-15  4  3 MIMO configuration 
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(4  4 MIMO) 
Communication is performed using four antennas at each of the 
transmission and reception stations. 
Figure 3.1.2.2-16 is displayed when 4  4 MIMO is selected in Channel 
Configuration. In this case, four waveform patterns corresponding to the 
four Rx antenna modulation signals are generated.  

 

 

Figure 3.1.2.2-16  4  4 MIMO configuration 
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Tx Antenna Configuration field 

Input waveform pattern settings can be configured in the Tx Antenna 
Configuration field (see Figure 3.1.2.2-17). 

 

 

Figure 3.1.2.2-17  Tx Antenna Configuration field 

 

Input File 

[Overview] Selects a waveform pattern file to be input. 

[Setting range] Display only 

[Remarks] Figure 3.1.2.2-18 is displayed when a waveform pattern 
file is selected. 

 

 

Figure 3.1.2.2-18  Reading confirmation window 

(when an ASCII3 is selected) 

 

The Peak value, RMS value, and the number of samples 
of the specified input waveform pattern file can be 
confirmed on this window. 
Clicking the [OK] button sets the waveform pattern, and 
clicking the [Cancel] button cancels the setting. 
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Input File (file type selection) 

[Overview] Sets the type of the file to be input. 

[Default] wvi 

[Setting range] wvi, ASCII1, ASCII2, ASCII3 

[Remarks] Refer to Section 4.5.6 “Input file format” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator 
MG3740A Analog Signal Generator Operation Manual 
(IQproducer™) for details on the file types. 

RF Frequency 

[Overview] Sets the center frequency. 

[Default] 10000.00000000 

[Unit] MHz 

[Setting range] 0.25000000 to 6000.00000000 
Setting resolution: 0.00000001 

[Remarks] The set value applies to Tx Antenna 1 to Tx Antenna 4. 
The Doppler frequency is recalculated when the RF 
Frequency setting is changed. 

Sampling Rate 

[Overview] Sets and displays the sampling rate. 

[Default] 0.02000000 

[Unit] MHz 

[Setting range] Display only (when a wvi file is selected) 
0.02000000 to 160.00000000 (Except for MG3740A) 
(when an ASCII1, ASCII2, or ASCII3 file is selected) 

 0.02000000 to 8.00000000 (MG3740A) 
(when an ASCII1, ASCII2, or ASCII3 file is selected) 

Display resolution: 0.00000001 

[Remarks] When a wvi file is selected in Input File, the sampling 
rate of the selected wvi file is displayed and cannot be 
edited. 

Bandwidth 

[Overview] Sets and displays the bandwidth. 

[Default] 0.02000000 

[Unit] MHz 

[Setting range] Display only (when a wvi file is selected) 
0.02000000 to Sampling Rate (when an ASCII1, ASCII2, 
or ASCII3 file is selected) 
Setting resolution: 0.00000001 
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[Remarks] When a wvi file is selected in Input File, the sampling 
rate of the selected wvi file is displayed and cannot be 
edited. 

Repetition 

[Overview] Sets the number of repetition for the waveform pattern. 

[Default] See Remarks. 

[Setting range] Maximum, or the range from the default value to the 
maximum value of memory capacity 

[Remarks] The default value is the minimum number of repetitions 
in which data points of the waveform pattern number 
are 1000 samples or more. 
When Maximum is set, the waveform pattern is 
repeated continuously until the maximum value of 
memory capacity is reached. 

Pattern length 

[Overview] Displays the waveform pattern length after generation. 
[Unit] ms 
[Setting range] Display only 

Display resolution: 0.0000001 
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Channel Setting field 

The fading profile, moving speed, and Doppler frequency can be set for 
each channel in the Channel Setting field (see Figure 3.1.2.2-19). 

 

Figure 3.1.2.2-19  Channel Setting field 

 

Fading Profile 

[Overview] Displays the fading profile. 

[Default] Default Setting 

[Remarks] Click the [Select Profile] button to display the profile 
list, and select a system to set the corresponding 
parameters. Refer to Appendix B for details. 
The channel settings are restored to their initial values 
when Default Setting is selected. 

Moving Speed 

[Overview] Sets the moving speed. 

[Default] 0.0 

[Unit] km/h 

[Setting range] 0.0 to 5000.0 
Setting resolution: 0.1 
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Doppler Frequency 

[Overview] Sets the Doppler frequency. 

[Default] 0.000 

[Unit] Hz 

[Setting range] The smaller value between 0.000 to (Sampling Rate)/2 
and the value calculated by the following equation is set. 

c

Frequency RF

3600

1000
5000   

 c: Speed of light (299,792,458 m/s) 
Setting resolution: 0.001 

Round Fading Pattern 

[Overview] Selects whether to make the start and end of 
fading-processed waveform patterns consecutive. 

[Default] Select 

[Setting range] Select/clear 

[Remarks] The start and end of fading-processed waveform 
patterns are consecutive when the check box is selected. 
The waveform patterns may not be consecutive if the 
Doppler frequency is low. Settings may also affect 
processing time. 

Random Seed 

[Overview] Sets a random seed used for fading processing. 

[Default] 1 (Channel1), 2 (Channel2), …, 16 (Channel16) 

[Setting range] 1 to 255 
Setting resolution: 1 

[Remarks] Changing the random seed changes the fading 
inclination of the waveform pattern to be generated. 
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Rx Antenna Configuration field 

Items of an output waveform pattern file can be set in the Rx Antenna 
Configuration field (see Figure 3.1.2.2-20). 

 

Figure 3.1.2.2-20  Rx Antenna Configuration field 

 

SG Primary/Secondary Setting 

[Overview] Specifies primary or secondary when multiple SG units 
are connected in the SIMO or MIMO configuration. 

[Default] Not Use 

[Setting range] Not Use, Primary,  
Secondary (Secondary1 to Secondary3) 

[Remarks] Refer to Appendix C for how to connect multiple SG 
units. 

AWGN 

[Overview] Sets AWGN On or Off. 

[Default] Cleared (Off) 

[Setting range] Select/clear 

[Remarks] AWGN addition is enabled when the check box is 
selected. 

AWGN Bandwidth 

[Overview] Sets the bandwidth of AWGN. 

[Default] 0.01000000 

[Unit] MHz 

[Setting range] 0.01000000 to (Sampling Rate)/2 
Setting resolution: 0.00000001 

 SG Primary/Secondary Setting：
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C/N 

[Overview] Sets the C/N. 

[Default] 0.00 

[Unit] dB 

[Setting range] –40.00 to +40.00 
Setting resolution: 0.01 

Marker 1 to Marker 3 

[Overview] Sets the marker name. 

[Setting range] Up to 31 one-byte alphanumeric characters. 

Pattern Sync Marker 

[Overview] Sets the marker to output the Pattern Sync Marker. 

[Default] Not Use 

[Setting range] Not Use, Marker1, Marker2, Marker3 

[Remarks] Refer to Section 3.5 “Marker Output” for details. 
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3.1.3 Channel tab window 
Figure 3.1.3-1 shows the Channel tab window. 

 
Channel n Parameter
field (n = 1 to 4) 

Power Delay Profile 
graph 

Path parameters 

 

Figure 3.1.3-1  Channel tab window 
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This section describes the parameters on the Channel tab window. 

Channel n Parameter fields (n = 1 to 16) 

The Tx Antenna settings corresponding to Channel n (n = 1 to 16) are 
displayed in the Channel n Parameter field (see Figure 3.1.3-2). 

 

 

Figure 3.1.3-2  Channel n Parameter field 

 

Input File 

[Overview] Displays the currently selected input file. 

[Setting range] Display only 

[Remarks] The parameter of the corresponding Tx Antenna is 
displayed. 

Fading Profile 

[Overview] Displays the currently selected fading profile. 

[Setting range] Display only 

[Remarks] The parameter of the corresponding Tx Antenna is 
displayed. 

RF Frequency 

[Overview] Displays the center frequency. 

[Setting range] Display only 

[Remarks] The parameter of the corresponding Tx Antenna is 
displayed. 

Sampling Rate 

[Overview] Displays the sampling rate. 

[Setting range] Display only 

[Remarks] The parameter of the corresponding Tx Antenna is 
displayed. 
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Bandwidth 

[Overview] Displays the bandwidth of the waveform pattern. 

[Setting range] Display only 

[Remarks] The parameter of the corresponding Tx Antenna is 
displayed. 

Pattern Length 

[Overview] Displays the waveform pattern length. 

[Setting range] Display only 

[Remarks] The parameter of the corresponding Tx Antenna is 
displayed. 

Path (1 to 20) 

Path 

[Overview] Sets the path number display to On or Off. 

[Default] Cleared (Off) 

[Setting range] Select/clear 

[Remarks] The Path parameters become enabled when the 
corresponding check box is selected. 

Fading Type 

[Overview] Sets the type of single path fading. 

[Default] Rayleigh 

[Setting range] Rayleigh, Rice, Constant 

[Remarks] 

 Rayleigh 
Environment in which multiple scattering waves 
arrive. 
Reception level changes in accordance with the 
Rayleigh distribution. 

 Rice 
Environment in which multiple scattering waves and 
direct waves arrive. 
Reception level changes in accordance with the Rice 
distribution. 

 Constant 
Reception level does not change with time. 
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Delay 

[Overview] Sets the delay. 

[Default] 0.0000 

[Unit] s 

[Setting range] 0.0000 to 2000.0000 
Setting resolution: 0.0001 

Power 

[Overview] Sets the path power. 

[Default] 0.00 

[Unit] dB 

[Setting range] –80.00 to 0.00 
Setting resolution: 0.01 

Rician K factor 

[Overview] Sets the power ratio between direct waves and 
scattering waves. 

[Default] 0.00 

[Unit] dB 

[Setting range] –40.00 to 40.00 
Setting resolution: 0.01 

[Remarks] Can be set when Fading Type is Rice. 

Angle of Arrival 

[Overview] Sets the arrival angle of direct waves. 

[Default] 0.0 

[Unit] deg 

[Setting range] 0.0 to 180.0 
Setting resolution: 0.1 

[Remarks] Can be set when Fading Type is Rice. 

Phase Shift 

[Overview] Sets the phase shift. 

[Default] 0.0 

[Unit] deg 

[Setting range] 0.0 to 359.9 
Setting resolution: 0.1 
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Spectrum Shape 

[Overview] Sets the shape of the Doppler spectrum. 

[Default] Classical 6 dB 

[Setting range] Classical 3 dB, Classical 6 dB, Flat, and Rounded 

[Details of parameter] 
Figure 3.1.3-3 shows each of the spectrum shapes. 

 

 

Figure 3.1.3-3  Doppler spectrum shapes 

 

[Remarks] Cannot be set when Constant is selected for Fading 
Type. 

Correlation Setting 

[Overview] Selects the correlation matrix setting method. 

[Default] Not Use 

[Setting range] Edit, Not Use, path number set in Edit. 

[Remarks] Enabled when a waveform data file is selected in Input 
File. 
When a path number is selected, the settings of the 
selected path will apply. Note, however, that no path 
number can be selected in the case of the 1  1 SISO 
configuration. 

Correlation Coefficients (Correlation matrix setting window) 

[Overview] Sets the correlation coefficients. 

[Default] 0.00000 

[Setting range] –1.00000 – j1.00000 to 1.00000 + j1.00000 
Only the elements on the upper-right of the diagonal 
components can be edited. 

[Remarks] The setting resolution is 0.00001 for both real and 
imaginary parts. 
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Correlation Matrix 

When Edit is selected in Correlation Setting, the correlation matrix 
setting window shown in Figure 3.1.3-4 is displayed (an example when 
Channel Configuration = 2  2 MIMO) and settings for all valid paths 
can be set. 
With the diagonal components of the Correlation Matrix as the border, 
the bottom left element is automatically set so that the upper right and 
bottom left elements form a complex conjugation. 

 Save, Recall File 

Copy To All Paths 

Kronecker method 

Correlation Matrix 

 

Figure 3.1.3-4  Correlation Matrix setting window (2  2 MIMO configuration) 

 

The element count of the matrix depends on the system 
configuration; the correspondence between the system 
configuration and the displayed element count is shown 
in Table 3.1.3-1. 
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Table 3.1.3-1  Correspondence between system configuration 

and displayed element count 

System Configuration Displayed Element Count 

1  2 SIMO, 2  1 MISO 2  2 matrix 
1  3 SIMO, 3  1 MISO 3  3 matrix 
1  4 SIMO, 4  1 MISO,  
2  2 MIMO 

4  4 matrix 

2  3 MIMO, 3  2 MIMO 6  6 matrix 
2  4 MIMO, 4  2 MIMO 8  8 matrix 
3  3 MIMO 9  9 matrix 
3  4 MIMO, 4  3 MIMO 12  12 matrix 
4  4 MIMO 16  16 matrix 

 
When a matrix element is selected in the Correlation 
Matrix setting window, the Input Complex Data window 
shown in Figure 3.1.3-5 is displayed and numeric values 
can be input. 

 

 

Figure 3.1.3-5  Input Complex Data window 

 

Kronecker Method 

[Overview] Sets Kronecker Method to On or Off. 

[Default] Cleared (Off) 

[Setting range] Select/clear 

[Remarks] The Kronecker product of Tx Correlation Matrix and Rx 
Correlation Matrix is displayed in the correlation matrix 
when this checkbox is selected. 

 
Click the [Save File…] button to save the Correlation Matrix parameters 
of a valid path into a CSV file. 
Click the [Recall File…] button to load a CSV file and set Correlation 
Matrix parameters. 
Click the [Copy To All Paths] button to copy the parameters of the set 
path to all other valid paths.  
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Power Delay Profile graph 

In the Power Delay Profile graph, the horizontal and vertical axes are 
Delay and Power, respectively, and the valid paths are displayed. All 
paths can be displayed by clicking the [Full Scale] button. 

 

Figure 3.1.3-6  Power Delay Profile graph 

 

As shown in Figure 3.1.3-7, a part of the graph can be enlarged by 
dragging the mouse to select the area. 

 

Figure 3.1.3-7  Selecting area to enlarge 

 

Figure 3.1.3-8 shows the graph after it is enlarged. 

 

Figure 3.1.3-8  Enlarged area 
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3.1.4 Moving Propagation tab window 
The Moving Propagation tab window is displayed when System 
Configuration is 1  1 SISO and Fading Profile is Moving Propagation. 
In moving propagation, the delay of Path2 to Path1 changes accordingly 
with the following equation. 

  tωsin1
2

A
BΔt   

Figure 3.1.4-1 shows the Moving Propagation tab window. 

 

Figure 3.1.4-1  Moving Propagation tab window 
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This section describes the parameters in the Moving Propagation tab 
window. 
The initial values for Path1 are all fixed to 0. 

Power 

[Overview] Sets the power of Path2. 

[Default] 0.00 

[Unit] dB 

[Setting range] –80.00 to 0.00 
Setting resolution: 0.01 

A (Offset) 

[Overview] Sets the offset for Path2. 

[Default] 5 

[Unit] s 

[Setting range] 0 to 500 
Setting resolution: 1 

B (Variation) 

[Overview] Sets amount of change in delay for Path2. 

[Default] 1 

[Unit] s 

[Setting range] 0 to 500 
Setting resolution: 1 

Omega 

[Overview] Sets Omega. 

[Default] 0.04 

[Unit] Hz 

[Setting range] 0.00 to 1.00 
Setting resolution: 0.01 
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3.1.5 Birth-Death Propagation tab window 
The Birth-Death Propagation tab window is displayed when System 
Configuration is 1  1 SISO and Fading Profile is Birth-Death 
Propagation. At Birth-Death Propagation, delay of two paths switches 
randomly. 

Figure 3.1.5-1 shows the Birth-Death Propagation tab window. 

 

 

Figure 3.1.5-1  Birth-Death Propagation tab window 
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This section describes the parameters in the Birth-Death Propagation 
tab window. 

Power 

[Overview] Sets the path power. 

[Default] 0.00 

[Unit] dB 

[Setting range] –80.00 to 0.00 
Setting resolution: 0.01 

Maximum Delay 

[Overview] Sets the maximum delay. 

[Default] 10 

[Unit] s 

[Setting range] 1 to 400 
Setting resolution: Delay Resolution 

[Remarks] The same value applies to Path1 and Path2. When 
Delay Resolution is changed, the maximum delay is 
rounded to an integer multiple of Delay Resolution. 

Delay Resolution 

[Overview] Sets the delay resolution. 

[Default] 1 

[Unit] s

[Setting range] 1 to Maximum Delay 
Setting resolution: 1 

[Remarks] The same value applies to Path1 and Path2. When 
Maximum Delay is changed to a value lower than the 
setting value of Delay Resolution, the setting value of 
Delay Resolution is set to the same value as Maximum 
Delay. 

Dwell time 

[Overview] Sets the dwell time. 

[Default] 191.000 

[Unit] ms 

[Setting range] 0.001 to 200.000 
Setting resolution: 0.001 
(Note that the set value is rounded according to the 
sampling rate.) 

[Remarks] The same value applies to Path1 and Path2. 
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Path Alternate Setting 

[Overview] Sets the path alternate setting. 

[Default] Random 

[Setting range] Random, Sequence 

[Remarks] When Random is set, Path1 and Path2 alternate 
randomly. 
When Sequence is set, the path to be alternated and the 
delay can be set. 

Path 

[Overview] Sets the path to be alternated. 

[Default] 1 

[Setting range] 1, 2, Termination 

[Remarks] Enabled when Sequence is selected in Path Alternate 
Setting. 

Delay 

[Overview] Sets the delay of the path. 

[Default] s 

[Setting range] 0 to Maximum Delay 
Setting resolution: Delay Resolution 

[Remarks] Enabled when Sequence is selected in Path Alternate 
Setting and the preceding Element is not set to 
Termination. 
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3.1.6 High Speed Train tab window 
The High Speed Train tab window is displayed when System 
Configuration is set to 1  1 SISO and Fading Profile is set to High Speed 
Train. 
In the case of High Speed Train for W-CDMA (BS), Scenario1 to 
Scenario3 can be selected. Scenario1 and Scenario3 are non-fading 
channels and Scenario2 is a Rice fading channel for Path1. Scenario 1 
and Scenario 2 can be set for LTE (BS). 

Figs. 3.1.6-1 to 3.1.6-3 show the High Speed Train tab windows for 
W-CDMA (BS), and Figure 3.1.6-4 shows the High Speed Train tab 
window for W-CDMA (MS). 

 

 

Figure 3.1.6-1  High Speed Train tab window (Scenario1) 
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Figure 3.1.6-2  High Speed Train tab window (Scenario2) 

 

 

 

Figure 3.1.6-3  High Speed Train tab window (Scenario3) 
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Figure 3.1.6-4  High Speed Train tab window (W-CDMA (MS)) 

 

This section describes the parameters on the High Speed Train tab 
window. 

Ds 

[Overview] Sets (the default value of the distance between BS and 
train)  2. 

[Default] 1000 (Scenario1), Infinity (Scenario2), 300 (Scenario3, 
W-CDMA(MS), and LTE(MS)) 

[Unit] m 

[Setting range] 0 to 2000 
Setting resolution: 1 

Dmin 

[Overview] Sets the distance between BS and rail. 

[Default]  50 (Scenario1), 2 (Scenario3, W-CDMA(MS), and 
LTE(MS)), invalid (Scenario2) 

[Unit] m 

[Setting range] 1 to 100 
Setting resolution: 1 
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Rician K factor 

[Overview] Sets the ratio between direct waves and scattering waves. 

[Default]  10.00 

[Unit] dB 

[Setting range] −40.00 to 40.00 
Setting resolution: 0.01 

Moving Speed 

[Overview] Sets the moving speed. 

[Default] 350.0 (Scenario1), 300.0 (Scenario2, Scenario3, 
W-CDMA(MS), and LTE(MS)) 

[Unit] km/h 

[Setting range] 0.0 to 5000.0 
Setting resolution: 0.1 

Maximum Doppler Frequency 

[Overview] Sets the maximum Doppler frequency. 

[Default] 1340 (Scenario1), 1150 (Scenario2 and Scenario3), 600 
(W-CDMA(MS)), 750(LTE(MS) ) 

[Unit] Hz 

[Setting range] 0.000 to 2000.000 
  Setting resolution: 0.001  
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3.1.7 Export File window 
This section describes the Export File window. 

The Export File window is used to set the package name, file name, 
comment, etc., of the waveform pattern. The Export File window is 
displayed when [Calculation] is selected from the [Edit] menu or the 

  button is clicked. The number of waveform patterns to be 
generated changes depending on the Channel Configuration setting. 
Table 3.1.7-1 shows the correspondence between the Channel 
Configuration setting and the number of waveform patterns to be 
generated. 

Table 3.1.7-1  Correspondence between Channel Configuration setting 

and number of waveform patterns 

Channel Configuration Setting Number of Waveform Patterns 

1  1 SISO 1 
1  2 SIMO 2 
1  3 SIMO 3 
1  4 SIMO 4 
2  1 MISO 1 
2  2 MIMO 2 
2  3 MIMO 3 
2  4 MIMO 4 
3  1 MISO 1 
3  2 MIMO 2 
3  3 MIMO 3 
3  4 MIMO 4 
4  1 MISO 1 
4  2 MIMO 2 
4  3 MIMO 3 
4  4 MIMO 4 

 
When one to four waveform patterns are generated, the waveform 
pattern names corresponding to Rx Antenna1 to Rx Antenna4 have “_1”, 
“_2”, “_3”, and “_4” suffixed, respectively, to the specified export file 
name. 

Figs. 3.1.7-1 to 3.1.7-4 show an example where the number of waveform 
patterns to be generated is one to four, respectively. In the Comment field, 
the RF frequency value and AWGN setting are initially displayed in the 
first and second text boxes, respectively. 
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Figure 3.1.7-1  Export File window (when generating one waveform pattern) 

 

 

Figure 3.1.7-2  Export File window (when generating  

two waveform patterns) 
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Figure 3.1.7-3  Export File window (when generating  

three waveform patterns) 

 

 

Figure 3.1.7-4  Export File window (when generating  

four waveform patterns) 

The Scaling setting is used to set the level of the generated waveform 
pattern.  

When RMS Value is selected, the waveform pattern amplitude is 
normalized so that the output waveform pattern has the specified RMS 
value.  

Conversely, when Output Gain is selected, the gain of the output data 
corresponding to the input data can be set (+0.0 to –10.0 dB). The output 
power is found by summing the powers on the assumption that there is 
no correlation for each channel and path. 
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RMS Value 

[Overview] Sets the RMS value. 

[Default] 1157 

[Setting range] 1 to 1634 
Setting resolution: 1 

[Remarks] In addition to manual setting, the RMS value can also be 
set automatically by selecting the Auto Setting check box. 
When the Auto Setting check box is selected to enable the 
automatic RMS value setting function, the RMS value is 
automatically adjusted and set so that the peak of the 
generated waveform pattern is not clipped. When the 
RMS value is 1 or less, however, clipping is performed 
setting the RMS value to 1.  

Auto Setting 

[Overview] Selects the automatic RMS value setting On/Off. 

[Default] When selected: 

[Setting range] Select/clear 

[Remarks] The RMS value is automatically set when the check box is 
selected. 

 



 

Chapter 3  Detailed Description of Functions 

3-48 

Output Gain 

[Overview] Sets the output gain. 

[Default] 0.0 

[Unite] dB 

[Setting range] 0.0 to −10.0 
Setting resolution: 0.1 

[Remarks] At Output Gain, processing is performed so the average 
level of the output data after fading processing matches 
the average level of the input data. (However, this 
assumes there is no correlation with each path and 
channel.)  
The coefficient used at this time is displayed as Gain 
Offset in Comment of the MG3700A/MG3710A/MG3740A 
setting screen (Figure 3.1.7-5). Actually, the next step 
adjusts the output level of the waveform data output from 
the SG according to the Output Gain setting.  
 

 

Figure 3.1.7-5  Gain Offset display 
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When the browse button for export destination folder selection is clicked, 
the folder selection window shown in Figure 3.1.7-6 is displayed. Select 
the export destination folder here. 

 

 

Figure 3.1.7-6  Export destination folder selection window 

 

If an export destination folder is not selected, the generated waveform 
pattern will be saved in the following folder: 

X:\IQproducer\Fading\Data 
(X:\IQproducer is the folder in which IQproducer™ is installed) 

One-byte alphanumeric characters and the symbols shown below can be 
used for the package name and file name: 

! % & ( ) + = ` { } _ - ^ @ [ ] 

The characters entered in the comment are displayed in the comment 
field on the MG3700A screen. The comment field may be left blank. 

Clicking the [OK] button starts waveform pattern generation. Note that 
all items other than comment must be set. 
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3.1.8 Calculation window 
Clicking Calculation & Load, Calculation & Play, or the OK button on 
the Export File window will start the waveform generation.  

The Calculation window shown in Figure 3.1.8-1 is displayed when the 
waveform pattern generation is started. 

 
Generation process
display window 

Progress bar 

[Cancel] button 

 

Figure 3.1.8-1  Calculation window (during waveform generation) 

 

Waveform pattern generation can be cancelled by clicking the [Cancel] 
button. Cancelling closes the Calculation window and returns to the 
main screen.  
When the waveform pattern generation is completed, “Calculation 
Completed” is displayed and the [Cancel] button changes to the [OK] 

button. 

When the generation is complete, you can return to the setting screen by 
clicking the OK button. After waveform generation, two files with .wvi 
and .wvd extension are output. 
 

 

 

Figure 3.1.8-2  Calculation window 

(when waveform generation is completed) 

 

At this time, the RMS value, peak value, whether clipping was done, and 
if so, the sample count, of the generated waveform pattern are displayed. 
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Note: 

When using this software on MG3710A/MG3740A and selecting 
Calculation & Load or Calculation & Play, the waveform 
generation ends without displaying the above screen.  

When multiple waveform patterns are generated, the window shown in 
Figure 3.1.8-3 is displayed at the completion of the waveform pattern 
generation. In this window, Level Offset shows the level ratio of signal 
generators (two signal generators in this example). Set the output level 
of the signal generators to these values when using multiple signal 
generators. The signal generator output levels are adjusted according to 
the RMS power of the generated waveform pattern. 

 

 

Figure 3.1.8-3  Calculation window with Level Offset display 
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3.1.9 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A/MG3740A.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation.  

Button for selecting load destination 

 

 

Figure 3.1.9-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen.  

 

Figure 3.1.9-2  Select Memory Screen 

After selecting the load destination of generated waveform in the Select 
Memory screen and clicking the OK button, the Load Setting screen will 
be shown again. Click the OK button in the Load Setting screen, and 
then the loading of waveform starts.  

Note: 

To exit this screen without loading the waveform pattern, click the 
Cancel button in the Load Setting screen.  
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3.1.10 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A/MG3740A.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 3.1.10-1  Select SG Screen 
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3.2 Saving/Reading Parameters 
The numeric values and settings for each item can be saved in a 
parameter file by using this software. 

3.2.1 Saving a parameter file 
When running on PC 

1. Select [Save Parameter File] from the [File] menu or click the   
tool button to display the parameter file saving screen. 

 

Figure 3.2.1-1  Parameter file saving screen 

 

2. Enter a file name in the [File name] text box, and click [Save] to 
save the parameter file. 
If the parameter file saving destination is not changed in [Save in], 
the parameter file will be saved in the following destination: 
X:\IQproducer\Fading\Entered file name.xml 
(X:\IQproducer is the folder in which IQproducer™ is installed) 
 

When running on MG3710A or MG3740A 

1. Click the [Save Parameter File] button in [File] menu or click the 

  button to display the parameter file saving screen.  
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Figure 3.2.1-2  Parameter file saving screen (MG3710A/MG3740A) 

 

2. Select the folder to store the file in the [Directories] field, and then 
enter the name of the file using the [File Name] box. Click [OK] to 
save the parameter file. To initialize the setting in the [Directories] 

field, click the [Default Root] button. 

 

3.2.2 Reading a parameter file 
When running on PC  

1. Select [Recall Parameter File] from the [File] menu or click the 

  tool button to display the parameter file reading screen.  

 

Figure 3.2.2-1  Parameter file reading screen 

 

2. Select a parameter file to be read from the file list, and then click 
[Open] to read the selected parameter file. 
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When running on MG3710A or MG3740A 

1. Select [Recall Parameter File] from the [File] menu or click the 
 tool button to display the parameter file reading screen.  

 

Figure 3.2.2-2  Parameter file reading screen (MG3710A/MG3740A) 

 

2. Select the directory where the files to be loaded is stored in the 
[Directories] field. Click the desired file from the [File List], and 
click [OK]. To initialize the setting in the [Directories] field, click the 
[Default Root] button. 
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3.3 Waveform Pattern Generation Procedure 
This section describes how to generate a waveform pattern, using the 
Fading waveform pattern as an example. 

3.3.1 1 × 1 SISO waveform generation 
How to generate a Multi Path waveform pattern for W-CDMA BS 
measurement reception is described below, using the MG3700A standard 
waveform pattern UL_RMC_12.2kbps as an example. 

<Procedure> 

1. Start this software. 

2. Set Common parameters. 

(1) Setting in System Configuration field 

 Select “1  1 SISO” from the Channel Configuration list box. 

 

Figure 3.3.1-1  System Configuration (1  1 SISO) 

 

(2) Setting in Tx Antenna Configuration field 

 Select “wvi” from the list box, and then click the [Reference] 
button to select a waveform pattern file to be input. 

 

Figure 3.3.1-2  Waveform pattern file selection window (1  1 SISO) 
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 Next, set “1980 MHz” for RF Frequency and “1” for Repetition. 
Figure 3.3.1-3 shows the screen after setting. 

 

Figure 3.3.1-3  Settings in Tx Antenna Configuration field 

 

(3) Setting in Channel Setting field 

 Click the [Select Profile] button and select the fading profile 
“W-CDMA(BS)/Case3/120km/h.” 

 

Figure 3.3.1-4  Selecting fading profile 

 

 Figure 3.3.1-5 shows the screen after the profile is selected. 

 

Figure 3.3.1-5  Settings in Channel Setting field 
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(4) Setting in Rx Antenna Configuration field 

 Configure the settings as shown in Figure 3.3.1-6. 

 

Figure 3.3.1-6  Settings in Rx Antenna Configuration field 

 

(5) Setting in Channel 1 Parameter field 

 Confirm that the settings configured in the Channel Setting 
field are displayed in the Channel 1 Parameter field on the 
Channel 1 tab window. 

 

Figure 3.3.1-7  Channel parameter setting screen (1  1 SISO) 

 SG Primary/Secondary Setting：
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3. Confirm that the parameters are correctly set. 

 Table 3.3.1-1 shows the parameters and their settings in this 
example. 

Table 3.3.1-1  W-CDMA (BS) parameter settings 

Parameter Setting 

System Configuration 

Channel Configuration 1  1 SISO 
Tx Antenna Configuration 
Input File UL_RMC_12_2kbps.wvi 
RF Frequency 1980 MHz 
Sampling Rate 11.52 MHz 
Bandwidth 3.84 MHz 
Repetition 1 
Pattern Length 10220.0 ms 
Channel Setting 
Fading Profile W-CDMA(BS)/Case3/120km/h 
Moving Speed 120 km/h 
Doppler Frequency 220.152 Hz 
Round Fading Pattern Selected 
Random Seed 1 (Default) 
Rx Antenna Configuration 
AWGN Cleared 

 



 

3.3 Waveform Pattern Generation Procedure 

3-61 

3 

D
etailed D

escription
 of F

u
n

ction
s 

4. Start calculation to generate the waveform. 

 Select [Calculation] from the [Edit] menu or click the   button 
to display the Export File window shown in Figure 3.3.1-8. Set the 
package name and export file name, and then click the [OK] button. 
Calculation is started and the waveform is generated. 

 

Figure 3.3.1-8  Export File window 

 

5. Figure 3.3.1-9 shows the spectrum of the generated waveform data. 

 

 

Figure 3.3.1-9  Spectrum (W-CDMA Case3 120km/h) 

 

 



 

Chapter 3  Detailed Description of Functions 

3-62 

3.3.2 Moving Propagation waveform generation 
How to generate a Moving Propagation waveform pattern for W-CDMA 
BS measurement reception is described below, using the MG3700A 
standard waveform pattern UL_RMC_12.2kbps as an example. 

<Procedure> 

1. Start this software. 

2. Set Common parameters. 

(1) Setting in System Configuration field 

 Select “1  1 SISO” from the Channel Configuration list box. 

 

Figure 3.3.2-1  System Configuration (1  1 SISO) 

 

(2) Setting in Tx Antenna Configuration field 

 Select “wvi” from the list box, and then click the [Reference] 
button to select a waveform pattern file to be input. 

 

Figure 3.3.2-2  Waveform pattern selection window 
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 Next, set “1980 MHz” for RF Frequency and “1” for Repetition. 
Figure 3.3.2-3 shows the screen after setting. 

 

Figure 3.3.2-3  Settings in Tx Antenna Configuration field 

 

(3) Setting in Channel Setting field 

 Click the [Select Profile] button and select the fading profile 
“W-CDMA(BS)/Moving Propagation.” 

 

Figure 3.3.2-4  Selecting fading profile 

 

 Figure 3.3.2-5 shows the screen after the profile is selected. 

 

Figure 3.3.2-5  Settings in Channel Setting field (Moving Propagation) 
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(4) Setting in Rx Antenna Configuration field 

 Configure the settings as shown in Figure 3.3.2-6. 

 

Figure 3.3.2-6  Settings in Rx Antenna Configuration field 

 

3. Set Path parameters on the Moving Propagation tab window. 

 Set the Path parameters as shown in Table 3.3.2-1. 
 

Table 3.3.2-1  Path parameter settings (Moving Propagation) 

Path Power [dB] A [s] B [s] Omega [Hz] 

0 0 0 0 0 
1 0.00 5 1 0.04 

 

 

 

Figure 3.3.2-7  Moving Propagation tab window 

 SG Primary/Secondary Setting：
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4. Confirm that the parameters are correctly set. 

 Table 3.3.2-2 shows the parameters and their setting in this 
example. 

Table 3.3.2-2  W-CDMA (BS) Moving Propagation parameter settings 

Parameter Setting 

System Configuration 

Channel Configuration 1  1 SISO 
Tx Antenna Configuration 
Input File UL_RMC_12_2kbps.wvi 
RF Frequency 1980 MHz 
Sampling Rate 11.52 MHz 
Bandwidth 3.84 MHz 
Repetition 1 
Pattern Length 10220.0 ms 
Channel Setting 
Fading Profile W-CDMA(BS)/Moving Propagation 
Rx Antenna Configuration 
AWGN Cleared 

 
5. Start calculation to generate the waveform. 

 Select [Calculation] from the [Edit] menu or click the   button 
to display the Export File window shown in Figure 3.3.2-8. Set the 
package name and export file name, and then click the [OK] button. 
Calculation is started and the waveform is generated. 

 

Figure 3.3.2-8  Export File window 
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6. Spectrum 

Figure 3.3.2-9 shows an FFT graph of the generated waveform data. 

Figure 3.3.2-9  Spectrum (Moving Propagation) 
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3.3.3 Birth-Death Propagation waveform generation 
How to generate a Birth-Death Propagation waveform pattern for 
W-CDMA BS measurement reception is described below, using the 
MG3700A standard waveform pattern UL_RMC_12.2kbps as an 
example. 

<Procedure> 

1. Start this software. 

2. Set Common parameters. 

(1) Setting in System Configuration field 

 Select “1  1 SISO” from the Channel Configuration list box. 

 

Figure 3.3.3-1  System Configuration (1  1 SISO) 

 

(2) Setting in Tx Antenna Configuration field 

 Select “wvi” from the list box, and then click the [Reference] 
button to select a waveform pattern file to be input. 

 

Figure 3.3.3-2  Waveform pattern selection window 
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 Next, set “1980 MHz” for RF Frequency and “1” for Repetition. 
Figure 3.3.3-3 shows the screen after setting. 

 

Figure 3.3.3-3  Settings in Tx Antenna Configuration field 

 

(3) Setting in Channel Setting field 

 Click the [Select Profile] button and select the fading profile 
“W-CDMA(BS)/Birth Death Propagation.” 

 

Figure 3.3.3-4  Selecting fading profile 

 

 Figure 3.3.3-5 shows the screen after the profile is selected. 

 

Figure 3.3.3-5  Settings in Channel Setting field (Birth-Death 

Propagation) 
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(4) Setting in Rx Antenna Configuration field 

 Configure the settings as shown in Figure 3.3.3-6. 

 

Figure 3.3.3-6  Settings in Rx Antenna Configuration field 

 

3. Set Path parameters on the Birth Death Propagation tab window. 

 Set the Path parameters as shown in Table 3.3.3-1. 
 

Table 3.3.3-1  Path parameter settings (Birth-Death Propagation) 

Path Power [dB] Minimum Delay [s] Delay Resolution [s] Dwell time [ms] 

0 0.00 10 1 191.000 
1 0.00 10 1 191.000 

 

 

 

Figure 3.3.3-7  Birth-Death Propagation tab window 

 SG Primary/Secondary Setting：
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In this example, the waveform pattern generation procedure when 
Random is selected for Path Alternate Setting is provided below.  
The path delay changes randomly when Random is selected for Path 
Alternate Setting, while the path can be alternated in a desired pattern 
when Sequence is selected. 

 

Figure 3.3.3-8  Example when Sequence is selected 

 

4. Confirm that the parameters are correctly set. 

 Table 3.3.3-2 shows the parameters and their setting in this 
example. 

Table 3.3.3-2  W-CDMA (BS) Birth-Death Propagation parameter settings 

Parameter Setting 

System Configuration 

Channel Configuration 1  1 SISO 
Tx Antenna Configuration 
Input File UL_RMC_12_2kbps.wvi 
RF Frequency 1980 MHz 
Sampling Rate 11.52 MHz 
Bandwidth 3.84 MHz 
Repetition 1 
Pattern Length 10220.0 ms 
Channel Setting 
Fading Profile W-CDMA(BS)/Birth-Death Propagation 
Rx Antenna Configuration 
AWGN Cleared 
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5. Start calculation to generate the waveform. 

 Select [Calculation] from the [Edit] menu or click the   button 
to display the Export File window shown in Figure 3.3.3-9. Set the 
package name and export file name, and then click the [OK] button. 
Calculation is started and the waveform is generated. 

 

Figure 3.3.3-9  Export File window 

 

6. Spectrum 

Figure 3.3.3-10 shows the spectrum of the generated waveform data. 

 

 

Figure 3.3.3-10  Spectrum (Birth-Death Propagation) 
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3.3.4 High Speed Train waveform generation 
How to generate a High Speed Train waveform pattern for W-CDMA BS 
measurement reception is described below, using the MG3700A standard 
waveform pattern UL_RMC_12.2kbps as an example. 

<Procedure> 

1. Start this software. 

2. Set Common parameters. 

(1) Setting in System Configuration field 

Select 1  1 SISO from the Channel Configuration list box. 

 

Figure 3.3.4-1  System Configuration (1  1 SISO) 

 

(2) Setting in Tx Antenna Configuration field 

Select the input file (wvi). 

 

 

Figure 3.3.4-2  Waveform pattern file selection window 
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Next, set 1980 MHz for RF Frequency and “1” for Repetition. 
Figure 3.3.4-3 shows the screen after setting. 

 

Figure 3.3.4-3  Tx Antenna Configuration 

 

(3) Setting in Channel Setting field 

Click the Select Profile and select the fading profile 
“W-CDMA(BS)/High Speed Train/Scenario1.” 

 

Figure 3.3.4-4  Selecting fading profile 

 

Figure 3.3.4-5 shows the screen after the profile is selected. 

 

Figure 3.3.4-5  Settings in Channel Setting field  

(High Speed Train) 
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(4) Setting in Rx Antenna Configuration field 

Configure the settings as shown in Figure 3.3.4-6. 

 

Figure 3.3.4-6  Settings in Rx Antenna Configuration field 

 

3. Set Path parameters on the High Speed Train tab window. 

Set the Path parameters as shown in Table 3.3.4-1. 

Table 3.3.4-1  Path parameter settings (High Speed Train) 

Ds [m] Dmin [m] Rician K factor [dB] Moving Speed [km/h] Maximum Doppler Frequency [Hz] 

1000 50  350.0 1340.000 

 

 

 

Figure 3.3.4-7  High Speed Train tab window (Scenario1) 

 SG Primary/Secondary Setting：
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4. Confirm that the parameters are correctly set. 

 Table 3.3.4-2 shows the parameters and their setting in this 
example. 

Table 3.3.4-2  W-CDMA(BS)/High Speed Train/Scenario1 parameter settings 

Parameter Setting 

System Configuration 
Channel Configuration 1  1 SISO 
Tx Antenna Configuration 
Input File UL_RMC_12_2kbps.wvi 
RF Frequency 1980 MHz 
Sampling Rate 11.52 MHz 
Bandwidth 3.84 MHz 
Repetition 1 
Pattern Length 10220.0 ms 
Channel Setting 
Fading Profile W-CDMA(BS)/High Speed Train/Scenario1 
Rx Antenna Configuration 
AWGN Cleared 

 
5. Start calculation to generate the waveform. 

 Select [Calculation] from the [Edit] menu or click the   button 
to display the Export File window shown in Figure 3.3.4-8. Set the 
package name and export file name, and then click the [OK] button. 
Calculation is started and the waveform is generated. 

 

Figure 3.3.4-8  Export File window  
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7. Spectrum 

Figure 3.3.4-9 shows the spectra of the generated waveform data. 

 

 

Figure 3.3.4-9  Spectrum (High Speed Train (Scenario1)) 
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3.3.5 2 × 2 MIMO waveform generation 
How to generate a 2  2 MIMO waveform pattern is described below, 
using the Mobile WiMAX waveform pattern as an example. 
In the example, “DL_MIMO_MatrixB_1.wvi” is created as the waveform 
pattern corresponding to Tx Antenna1, and “DL_MIMO_MatrixB_2.wvi” 
as the waveform pattern corresponding to Tx Antenna2. 

<Procedure> 

1. Start this software. 

2. Set Common parameters. 

(1) Setting in System Configuration field 

 Select “2  2 MIMO” from the Channel Configuration list box. 

 

Figure 3.3.5-1  System Configuration (2  2 MIMO) 

 

(2) Setting for Tx Antenna 1 and Tx Antenna 2 in Tx Antenna 
Configuration field 

 Select “wvi” from the list box, and then click the [Reference] 
button to select a waveform pattern file to be input. 

 

Figure 3.3.5-2  Waveform pattern file selection window (2  2 MIMO) 
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 Next, set “2400 MHz” for RF Frequency and “1” for Repetition 
on the Tx Antenna 1 tab window and the Tx Antenna 2 tab 
window. Figs. 3.3.5-3 and 3.3.5-4 show the screen after setting. 

 

 

Figure 3.3.5-3  Settings on Tx Antenna 1 tab window 

 

 

 

Figure 3.3.5-4  Settings on Tx Antenna 2 tab window 

 

(3) Settings in Channel Setting field 

 Configure the settings for Channel 1 to Channel 4. On each 
Channel tab window, click the [Select Profile] button and select 
the fading profile “MIMO Mobile WiMAX/2x2 MIMO/ITU 
Vehicular A/Medium Correlation.” 

 

Figure 3.3.5-5  Setting in Channel Setting field 
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 Figure 3.3.5-6 shows the Channel1 tab window after the profile 
is selected as an example. 

 

Figure 3.3.5-6  Settings on Channel1 tab window 

 

(4) Setting for Rx Antenna 1 and Rx Antenna 2 in Rx Antenna 
Configuration field 

 Configure the settings as shown in Figs. 3.3.5-7 and 3.3.5-8. 

 

Figure 3.3.5-7  Settings on Rx Antenna1 tab window 

 

 

Figure 3.3.5-8  Settings on Rx Antenna2 tab window 

 

 SG Primary/Secondary Setting：  Secondary 

 SG Primary/Secondary Setting：  Primary
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(5) Setting in Channel n parameter field (n = 1 to 4) 

 Confirm that the settings configured in the Channel Setting 
field are displayed in the Channel Parameter field on each 
Channel tab window. 

 

Figure 3.3.5-9  Channel parameter setting screen (2  2 MIMO) 
 

 Select Correlation Setting of Path1, select Edit to display the 
Correlation matrix setting window, and then configure the settings. 
The configured settings commonly apply to Channels 1 to 4. 

 Figure 3.3.5-10 shows the Correlation Matrix setting window after 
setting. 
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Figure 3.3.5-10  Correlation Matrix setting window 

(Path Correlation Matrix) 
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3. Confirm that the parameters are correctly set. 

 Table 3.3.5-1 shows the parameters and their setting in this 
example. 

Table 3.3.5-1  Mobile WiMAX parameter settings 

Parameter Setting 

System Configuration 

Channel Configuration 2  2 MIMO 
Tx Antenna Configuration (Tx Antenna1 and Tx Antenna2) 
Input File (Tx Antenna1)  DL_MIMO_MatrixB_1.wvi 
Input File (Tx Antenna2) DL_MIMO_MatrixB_2.wvi 
RF Frequency  2400 MHz 
Sampling Rate  22.4 MHz 
Bandwidth  10 MHz 
Repetition  1 
Pattern Length  5 ms 
Channel Setting (Channel 1 to Channel 4) 
Fading Profile MIMO Mobile WiMAX/2x2 

MIMO/ITU Vehicular A/Medium 
Correlation 

Moving Speed 60 km/h 
Doppler Frequency 133.426 Hz 
Round Fading Pattern Selected 
Random Seed Initial value 
Rx Antenna Configuration (Rx Antenna1 and Rx Antenna2) 
AWGN OFF 
Channel (1 to 4) setting 
Spectrum Shape Classical 6 dB 
Correlation Setting (Path 1 to Path 6) 
(Medium correlation) 
 Channel1 Channel2 Channel3 Channel4 

Channel1 1 0.0 0.7264 0.0 
Channel2 0.0 1 0.0 –0.7264 
Channel3 0.7264 0.0 1 0.0 
Channel4 0.0 –0.7264 0.0 1 
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4. Start calculation to generate the waveform. 

 Select [Calculation] from the [Edit] menu or click the   button 
to display the Export File window shown in Figure 3.3.5-11. Set the 
package name and export file name, and then click the [OK] button. 
Calculation is started and the waveform is generated. 

 

Figure 3.3.5-11  Export File window 

 

 When the waveform generation is completed, the window shown in 
Figure 3.3.5-12 is displayed. In this window, Level Offset shows the 
level ratio of two signal generators. Set the output level of the signal 
generators to these values when using two signal generators. 

 

Figure 3.3.5-12  Window when waveform generation is completed 
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5. Figs. 3.3.5-13 and 3.3.5-14 show the spectra of the generated 
waveform data, for Rx Antenna1 and Rx Antenna2, respectively. 

 

 

Figure 3.3.5-13  Spectrum (Rx Antenna 1) 

 

 

 

Figure 3.3.5-14  Spectrum (Rx Antenna 2) 
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3.4 Displaying Graph 
The generated waveform pattern can be displayed in a CCDF or FFT 
graph by using this software. Refer to Sections 4.3 “CCDF Graph 
Display” and 4.4 “FFT Graph Display” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™) for details on 
displaying graphs. 

Displaying CCDF graph 

1. Generate a Fading waveform pattern by executing “Calculation.” 

2. Select [CCDF] from the [Simulation] menu or click the   tool 
button. The CCDF Graph Monitor screen shown in Figure 3.4-1 is 
displayed with the trace of the generated waveform pattern. 

 

 

Figure 3.4-1  CCDF Graph Monitor screen 

 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the 
CCDF Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed in either of the following two 
methods: 

 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
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Note: 

A CCDF graph and an FFT graph cannot be generated at the same 
time. When both graphs are to be displayed, complete one graph 
generation before generating the other graph.  

 When displaying a new trace in the same screen with the previous traces: 

1. Set [Add] for [Quick Add Mode] on the lower-left of the CCDF Graph 
Monitor screen. 

2. Select [CCDF] from the [Simulation] menu or click the   tool 
button. The trace of the waveform pattern newly generated is 
additionally displayed in the CCDF Graph Monitor screen. 
Up to eight traces can be displayed by repeating this procedure. 

 When deleting the previous traces to display a new trace: 

1. Set [Clear] for [Quick Add Mode] on the lower-left of the CCDF 
Graph Monitor screen. 

2. Select [CCDF] from the [Simulation] menu or click the   tool 
button. The confirmation message shown in Figure 3.4-2 below 
appears: 

 

Figure 3.4-2  Confirmation message 

 

 Click [Yes]. The previous traces are deleted from the CCDF Graph 
Monitor screen, and the trace of the waveform pattern newly 
generated is displayed. 
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Displaying FFT graph 

1. Generate a Fading waveform pattern by executing “Calculation”. 

2. Select [FFT] from the [Simulation] menu or click the   tool 
button. The FFT Graph Monitor screen shown in Figure 3.4-3 is 
displayed with the trace of the generated waveform pattern. 

 

 

Figure 3.4-3  FFT Graph Monitor screen 

 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the FFT 
Graph Monitor screen, the trace of the waveform pattern newly 
generated can be displayed in either of the following two methods: 

 Displaying the new trace in the same screen as the previous 
traces 

 Deleting the previous traces to display the new trace 
 

Note: 

A CCDF graph and an FFT graph cannot be generated at the same 
time. When both graphs are to be displayed, complete one graph 
generation before generating the other graph.  
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 When displaying a new trace in the same screen with the previous traces: 

1. Set [Add] for [Quick Add Mode] on the lower-left of the FFT Graph 
Monitor screen. 

2. Select [FFT] from the [Simulation] menu or click the   tool 
button. The trace of the waveform pattern newly generated is 
additionally displayed in the FFT Graph Monitor screen. 
Up to four traces can be displayed by repeating this procedure. 

 When deleting the previous traces to display a new trace: 

1. Set [Clear] for [Quick Add Mode] on the lower-left of the FFT Graph 
Monitor screen. 

2. Select [FFT] from the [Simulation] menu or click the   tool 
button. The confirmation message shown in Figure 3.4-4 below 
appears: 

 

Figure 3.4-4  Confirmation message 

 

 Click the [Yes] button. The previous traces are deleted from the FFT 
Graph Monitor screen, and the trace of the waveform pattern newly 
generated is displayed.  
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3.5 Marker Output 
This software sets the marker as follows. 

 1  1 SISO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern. 
 

 1  2 SIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to Rx Antenna1 and Rx Antenna2 waveform patterns. 
 

 1  3 SIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to Rx Antenna1 to Rx Antenna3 waveform patterns. 
 

 1  4 SIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to Rx Antenna1 to Rx Antenna4 waveform patterns. 
 

 2  1 MISO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern. 
 

 2  2 MIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern, and the marker signal 
of the waveform pattern set for Tx Antenna2 is output to the Rx 
Antenna2 waveform pattern. 
 

 2  3 MIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern, and the marker signal 
of the waveform pattern set for Tx Antenna2 is output to the Rx 
Antenna2 and Rx Antenna3 waveform patterns. 
 

 2  4 MIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 and Rx Antenna2 waveform patterns, and 
the marker signal of the waveform pattern set for Tx Antenna2 is 
output to the Rx Antenna3 and Rx Antenna4 waveform patterns. 
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 3  1 MISO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern. 
 

 3  2 MIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern, and the marker signal 
of the waveform pattern set for Tx Antenna2 is output to the Rx 
Antenna2 waveform pattern. 
 

 3  3 MIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern, the marker signal of the 
waveform pattern set for Tx Antenna2 is output to the Rx Antenna2 
waveform pattern, and the marker signal of the waveform pattern set 
for Tx Antenna3 is output to the Rx Antenna3 waveform pattern. 
 

 3  4 MIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern, the marker signal of the 
waveform pattern set for Tx Antenna2 is output to the Rx Antenna2 
waveform pattern, and the marker signal of the waveform pattern set 
for Tx Antenna3 is output to the Rx Antenna3 and Rx Antenna4 
waveform patterns. 
 

 4  1 MISO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern. 
 

 4  2 MIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern, and the marker signal 
of the waveform pattern set for Tx Antenna2 is output to the Rx 
Antenna2 waveform pattern. 
 

 4  3 MIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern, the marker signal of the 
waveform pattern set for Tx Antenna2 is output to the Rx Antenna2 
waveform pattern, and the marker signal of the waveform pattern set 
for Tx Antenna3 is output to the Rx Antenna3 waveform pattern.  
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 4  4 MIMO configuration 
The marker signal of the waveform pattern set for Tx Antenna1 is 
output to the Rx Antenna1 waveform pattern, the marker signal of the 
waveform pattern set for Tx Antenna2 is output to the Rx Antenna2 
waveform pattern, the marker signal of the waveform pattern set for 
Tx Antenna3 is output to the Rx Antenna3 waveform pattern, and the 
marker signal of the waveform pattern set for Tx Antenna4 is output 
to the Rx Antenna4 waveform pattern. 
 

For the marker set in Pattern Sync Marker on the Marker Setting 
window, the marker signal is overwritten and output to the head of the 
waveform pattern as shown in Figure 3.5-1. 

 

Figure 3.5-1  Pattern Sync Marker signal and RF output 
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The following operations are required to output a modulated signal from 
this equipment using the waveform pattern generated by this software: 

• Transferring waveform pattern to internal hard disk 
• Loading waveform patterns from the hard disk to the waveform 

memory 
• Selecting a waveform pattern to be output from this equipment 
 
This chapter explains the details of these operations. 

 

4.1 For MG3700A, MG3710A or MG3740A .................... 4-2 
4.1.1 Transferring waveform pattern 

 to internal hard disk ..................................... 4-2 
4.1.2 Loading to Waveform Memory ...................... 4-4 
4.1.3 Selecting Waveform Pattern .......................... 4-5 
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4.1 For MG3700A, MG3710A or MG3740A 
This section describes how to download a waveform pattern created for 
the MG3700A/MG3710A/MG3740A to the hard disk of the 
MG3700A/MG3710A/MG3740A and output the pattern.  

4.1.1 Transferring waveform pattern to internal hard disk 
The waveform pattern created with this software can be transferred to 
the internal hard disk in the following ways:  

Note: 
This operation is not necessary if you are using 
MG3710A/MG3740A and have generated waveform patterns on 
MG3710A/MG3740A.  

For MG3700A 
• LAN 
• CompactFlash Card 
 
For MG3710A or MG3740A 
• LAN 
• External device such as USB flash drive 
 
 Transferring from PC via LAN (MG3700A, MG3710A, MG3740A) 
Two IQproducer™ tools can be used to transfer a waveform pattern to 
the MG3700A/MG3710A/MG3740A via a LAN.  

• Transfer & Setting Wizard 
Start this wizard by clicking the Transfer & Setting Wizard button of 
this software or by selecting Simulation & Utility tab → Transfer & 
Setting Wizard from the IQproducer™ after creating a waveform 
pattern. For details, refer to Section 4.7 “File Transfer and Loading to 
Memory Using Transfer & Setting Wizard” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™).  
Transferring a waveform pattern to the internal hard disk of the 
MG3700A/MG3710A/MG3740A, loading the waveform from the hard 
disk to the waveform memory, and then outputting the waveform 
pattern can be done using this wizard.  
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• Transfer & Setting Panel 
This function is loaded by selecting Transfer & Setting Panel in the 
Simulation & Utility tab of the IQproducer™. For details, refer to 
Section 5.2 “Transferring Waveform Pattern” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™).  
Specify the folder that contains the waveform pattern to transfer to 
the MG3700A/MG3710A/MG3740A in the PC-side tree of Transfer & 
Setting Panel. 
 

 Transferring using a CF card (MG3700A) 
Copy the waveform pattern (***.wvi and ***.wvd files) to be downloaded 
to the MG3700A to the root directory of a CF card.  

Insert the CF card into the card slot on the front panel of the MG3700A, 
and then copy the file to the hard disk. For details about how to use a CF 
card to transfer a waveform pattern, refer to (1) Loading waveform file in 
memory in Section 3.5.2 of the MG3700A Vector Signal Generator 
Operation Manual (Mainframe). 

 Transferring via external device such as USB flash drive (MG3710A, 
MG3740A) 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MG3710A/MG3740A, refer to Section 
7.3.6 “Copying external waveform pattern: Copy” in the 
MG3710A/MG3710E Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe).  
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4.1.2 Loading to Waveform Memory 
To output a modulated signal using a waveform pattern, it is necessary to 
load the waveform pattern that was transferred to the internal hard disk 
of the MG3700A/MG3710A/MG3740A (described in Section 4.1.1 
“Transferring waveform pattern to internal hard disk”) to the waveform 
memory. A waveform pattern can be loaded into the waveform memory in 
the following two ways. 

 Configuring using the mainframe  
A waveform pattern can be loaded into the waveform memory by using 
the instruction panel of the MG3700A/MG3710A/MG3740A or by using a 
remote command.  

For operation using the front panel, refer below: 

• Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A 
Vector Signal Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the 
MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal 
Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the 
MG3710A/MG710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 

 
 Using Transfer & Setting Panel of IQproducer™ 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory by using Transfer & Setting Panel, which can be opened from 
the Simulation & Utility tab. For details, refer to Section 4.6 “File 
Transfer and Loading to Memory Using Transfer & Setting Panel” in the 
MG3700A/MG3710A/MG3710E Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (IQproducer™). 
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4.1.3 Selecting Waveform Pattern 
Select a waveform pattern to use for modulation from the waveform 
patterns loaded into the waveform memory of the 
MG3700A/MG3710A/MG3740A according to Section 4.1.2 “Loading to 
waveform memory”. A waveform pattern can be selected in the following 
two ways. 

 Configuring using the MG3700A/MG3710A/MG3740A 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.  

For operation using the front panel, refer below:  

• Section 3.5.2 (4) “Outputting pattern loaded in Memory A for 
modulation in Edit mode” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 

 

 Using Transfer & Setting Panel of IQproducer™ 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory, and also selected for modulation. This is done by using Transfer 
& Setting Panel, which can be opened from the Simulation & Utility tab. 
For details, refer to Section 4.6 “File Transfer and Loading to Memory 
Using Transfer & Setting Panel” in the MG3700A/MG3710A/MG3710E 
Vector Signal Generator MG3740A Analog Signal Generator Operation 
Manual (IQproducer™). 
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A list of error messages is shown below.  In this list, x, n1, and n2 
indicate a numeric value, and s indicates a character string. 

Table A-1  Error messages 

Error Message Description 

The Setting value is out of range.(“s = x(n1 – n2)”) The value of x set in parameter s is out of the 
setting range between n1 and n2. 

Cannot write file Data cannot be written to the file. 
Cannot read file The file cannot be read. 
Cannot open file. The file cannot be opend. 
Cannot write file(“s”). Data cannot be written to file s. 
Input File is not found(“s”). File s cannot be found. 
Invalid file format. The file format is invalid. 
Invalid file format. (s) The format of file s is invalid. 
Input Package Name. Input a package name. 
Input Export File Name. Input an export file name. 
Input File is not selected. An input file has not been selected.  
Cannot calculate because all paths are disable in 
some channels. 

Calculation cannot be done because there is a 
channel with all its paths disabled. 

Wrong pattern license. The license for the waveform pattern selected is 
invalid. 

Out of Range：Sampling Rate (kHz) (20-8000) The sampling rate is out of the range of 20 to 
8000 kHz. 

Out of Range：Sampling Rate (MHz) (0.02-8) The sampling rate is out of the range of 0.02 to 8 
MHz. 

Sampling Rate is mismatch. The sampling rate of the waveform pattern set in 
Tx Antenna do not match. 

Data Points is mismatch. The number of data points of the waveform 
pattern set in Tx Antenna do not match. 

Spectrum is mismatch. The waveform spectrum set in Tx Antenna does 
not match. 

This pattern cannot use. Because “Internal FIR” 
is used. 

Calculation cannot be done because “Internal 
FIR” is used in the selected pattern file.  

The number of samples is over 256M samples. The waveform pattern size after generation is 
over 256 Msamples. 

The number of samples is over 512M samples. The waveform pattern size after generation is 
over 512 M samples. 

Not enough hard disk space. — 
 

 



 

Appendix A  Error Messages 

A-2. 

A list of warning messages is shown below. 

Table A-2  Warning messages 

Warning Message Description 

Input waveform pattern include some licensed 
patterns. 

A waveform pattern that requires a license has 
been selected. 

Clipping was done. The clipping has been completed. 
n1 samples were clipped. n1 sample(s) have been clipped. 
If you change Input File Format, the file 
information currently opened will be discarded. 
Are you sure to change Input File Format? 

Current information will be lost if the input file 
format is changed. 
Are you sure you want to change the input file 
format? 
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Table B-1  GSM [1] 

Fading Profile Path Type Delay [us] Power [dB] 

Rural Area 6 tap 
(Moving Speed = 130 km/h 

Rician K factor = 6.89 dB 
Angle of Arrival = 45 deg) 

1 Rice 0.0 0.0 
2 Rayleigh 0.1 −4.0 
3 Rayleigh 0.2 −8.0 
4 Rayleigh 0.3 −12.0 
5 Rayleigh 0.4 −16.0 
6 Rayleigh 0.5 −20.0 

Rural Area 4 tap 
(Moving Speed = 130 km/h 

Rician K factor = 8.26 dB 
Angle of Arrival = 45 deg) 

1 Rice 0.0 0.0 
2 Rayleigh 0.2 −2.0 
3 Rayleigh 0.4 −10.0 
4 Rayleigh 0.6 −20.0 

Hilly Terrain 12 tap-1 
(Moving Speed 100 = km/h) 

1 Rayleigh 0.0 −10.0 
2 Rayleigh 0.1 −8.0 
3 Rayleigh 0.3 −6.0 
4 Rayleigh 0.5 −4.0 
5 Rayleigh 0.7 0.0 
6 Rayleigh 1.0 0.0 
7 Rayleigh 1.3 −4.0 
8 Rayleigh 15.0 −8.0 
9 Rayleigh 15.2 −9.0 

10 Rayleigh 15.7 −10.0 
11 Rayleigh 17.2 −12.0 
12 Rayleigh 20.0 −14.0 

Hilly Terrain 12 tap-2 
(Moving Speed = 100 km/h) 

1 Rayleigh 0.0 −10.0 
2 Rayleigh 0.2 −8.0 
3 Rayleigh 0.4 −6.0 
4 Rayleigh 0.6 −4.0 
5 Rayleigh 0.8 0.0 
6 Rayleigh 2.0 0.0 
7 Rayleigh 2.4 −4.0 
8 Rayleigh 15.0 −8.0 
9 Rayleigh 15.2 −9.0 

10 Rayleigh 15.8 −10.0 
11 Rayleigh 17.2 −12.0 
12 Rayleigh 20.0 −14.0 

Hilly Terrain 6 tap-1 
(Moving Speed = 100 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.1 −1.5 
3 Rayleigh 0.3 −4.5 
4 Rayleigh 0.5 −7.5 
5 Rayleigh 15.0 −8.0 
6 Rayleigh 17.2 −17.7 
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Table B-1  GSM [1] (Cont’d) 

Fading Profile Path Type Delay [us] Power [dB] 

Hilly Terrain 6 tap-2 
(Moving Speed = 100 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.2 −2.0 
3 Rayleigh 0.4 −4.0 
4 Rayleigh 0.6 −7.0 
5 Rayleigh 15.0 −6.0 
6 Rayleigh 17.2 −12.0 

Urban Area 12 tap-1 
(Moving Speed = 100 km/h) 

1 Rayleigh 0.0 −4.0 
2 Rayleigh 0.1 −3.0 
3 Rayleigh 0.3 0.0 
4 Rayleigh 0.5 −2.6 
5 Rayleigh 0.8 −3.0 
6 Rayleigh 1.1 −5.0 
7 Rayleigh 1.3 −7.0 
8 Rayleigh 1.7 −5.0 
9 Rayleigh 2.3 −6.5 

10 Rayleigh 3.1 −8.6 
11 Rayleigh 3.2 −11.0 
12 Rayleigh 5.0 −10.0 

Urban Area 12 tap-2 
(Moving Speed = 100 km) 

1 Rayleigh 0.0 −4.0 
2 Rayleigh 0.2 −3.0 
3 Rayleigh 0.4 0.0 
4 Rayleigh 0.6 −2.0 
5 Rayleigh 0.8 −3.0 
6 Rayleigh 1.2 −5.0 
7 Rayleigh 1.4 −7.0 
8 Rayleigh 1.8 −5.0 
9 Rayleigh 2.4 −6.0 

10 Rayleigh 3.0 −9.0 
11 Rayleigh 3.2 −11.0 
12 Rayleigh 5.0 −10.0 

Urban Area 6 tap-1 
(Moving Speed = 100 km/h) 

1 Rayleigh 0.0 −3.0 
2 Rayleigh 0.2 0.0 
3 Rayleigh 0.5 −2.0 
4 Rayleigh 1.6 −6.0 
5 Rayleigh 2.3 −8.0 
6 Rayleigh 5.0 −10.0 

Urban Area 6 tap-2 
(Moving Speed = 100 km/h) 

1 Rayleigh 0.0 −3.0 
2 Rayleigh 0.2 0.0 
3 Rayleigh 0.6 −2.0 
4 Rayleigh 1.6 −6.0 
5 Rayleigh 2.4 −8.0 
6 Rayleigh 5.0 −10.0 
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Table B-1  GSM [1] (Cont’d) 

Fading Profile Path Type Delay [us] Power [dB] 

Equalization Test 6 tap 
(Moving Speed = 100 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 3.2 0.0 
3 Rayleigh 6.4 0.0 
4 Rayleigh 9.6 0.0 
5 Rayleigh 12.8 0.0 
6 Rayleigh 16.0 0.0 

Typical small cell 2 tap 
(Moving Speed = 5 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.4 0.0 
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Table B-2  W-CDMA (MS) [2] 

Fading Profile Path Type Delay [us] Power [dB] 

Case 1 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 −10.0 

Case 2 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.976 0.0 

3 Rayleigh 20 0.0 

Case 3 
92 km/h (Moving Speed = 92 km/h) 
120 km/h (Moving Speed = 120 km/h) 
166 km/h (Moving Speed = 166 km/h) 
282 km/h (Moving Speed = 282 km/h) 
320 km/h (Moving Speed = 320 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.26 −3.0 
3 Rayleigh 0.521 −6.0 

4 Rayleigh 0.781 −9.0 

Case 4 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 0.0 

Case 5 
38 km/h (Moving Speed = 38 km/h) 
50 km/h (Moving Speed = 50 km/h) 
69 km/h (Moving Speed = 69 km/h) 
118 km/h (Moving Speed = 118 km/h) 
133 km/h (Moving Speed = 133 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 −10.0 

Case 6 
192 km/h (Moving Speed = 192 km/h) 
250 km/h (Moving Speed = 250 km/h) 
345 km/h (Moving Speed = 345 km/h) 
583 km/h (Moving Speed = 583 km/h) 
688 km/h (Moving Speed = 688 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.26 −3.0 
3 Rayleigh 0.521 −6.0 

4 Rayleigh 0.781 −9.0 

Moving propagation  
Birth-Death propagation 
High Speed Train  

Refer to Sections 3.1.4 “Moving Propagation tab window,” 
3.1.5 “Birth-Death Propagation tab window,” and 3.1.6 “High 
Speed Train tab window.” 
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Table B-3  W-CDMA (BS) [3] 

Fading Profile Path Type Delay [us] Power [dB] 

Case1 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 −10.0 

Case2 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.976 0.0 

3 Rayleigh 20 0.0 

Case3 
92 km/h (Moving Speed = 92 km/h) 
120 km/h (Moving Speed = 120 km/h) 
166 km/h (Moving Speed = 166 km/h) 
280 km/h (Moving Speed = 280 km/h) 
320 km/h (Moving Speed = 320 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.26 −3.0 
3 Rayleigh 0.521 −6.0 

4 Rayleigh 0.781 −9.0 

Case4 
192 km/h (Moving Speed = 192 km/h) 
250 km/h (Moving Speed = 250 km/h) 
345 km/h (Moving Speed = 345 km/h) 
583 km/h (Moving Speed = 583 km/h) 
668 km/h (Moving Speed = 668 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.260 −3.0 
3 Rayleigh 0.521 −6.0 

4 Rayleigh 0.781 −9.0 

Moving propagation  
Birth-Death propagation 
High Speed Train  

Refer to Sections 3.1.4 “Moving Propagation tab window,” 
3.1.5 “Birth-Death Propagation tab window,” and 3.1.6 “High 
Speed Train tab window.” 
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Table B-4  HSDPA [2] 

Fading Profile Path Type Delay [us] Power [dB] 

Case1 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 −10.0 

Case2 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 0.0 

3 Rayleigh 20 0.0 

Case3 
92 km/h (Moving Speed = 92 km/h) 
120 km/h (Moving Speed = 120 km/h) 
166 km/h (Moving Speed = 166 km/h) 
282 km/h (Moving Speed = 282 km/h) 
320 km/h (Moving Speed = 320 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.26 −3.0 
3 Rayleigh 0.521 −6.0 

4 Rayleigh 0.781 −9.0 

Case4 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 0.0 

Case5 
38 km/h (Moving Speed = 38 km/h) 
50 km/h (Moving Speed = 50 km/h) 
69 km/h (Moving Speed = 69 km/h) 
118 km/h (Moving Speed = 118 km/h) 
133 km/h (Moving Speed = 133 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 −10.0 

Case6 
192 km/h (Moving Speed = 192 km/h) 
250 km/h (Moving Speed = 250 km/h) 
345 km/h (Moving Speed = 345 km/h) 
583 km/h (Moving Speed = 583 km/h) 
688 km/h (Moving Speed = 688 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.26 −3.0 
3 Rayleigh 0.521 −6.0 

4 Rayleigh 0.781 −9.0 

Case8 
23 km/h (Moving Speed = 23 km/h) 
30 km/h (Moving Speed = 30 km/h) 
41 km/h (Moving Speed = 41 km/h) 
71 km/h (Moving Speed = 71 km/h) 
80 km/h (Moving Speed = 80 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 −10.0 

ITU Pedestrian A 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.11 −9.7 
3 Rayleigh 0.19 −19.2 

4 Rayleigh 0.41 −22.8 
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Table B-4  HSDPA [2] (Continued) 

Fading Profile Path Type Delay [us] Power [dB] 

ITU Pedestrian B 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h)  
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.2 −0.9 
3 Rayleigh 0.8 −4.9 
4 Rayleigh 1.2 −8.0 
5 Rayleigh 2.3 −7.8 
6 Rayleigh 3.7 −23.9 

ITU Vehicular A 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
23 km/h (Moving Speed = 23 km/h) 
30 km/h (Moving Speed = 30 km/h) 
41 km/h (Moving Speed = 41 km/h) 
71 km/h (Moving Speed = 71 km/h) 
80 km/h (Moving Speed = 80 km/h) 
92 km/h (Moving Speed = 92 km/h) 
120 km/h (Moving Speed = 120 km/h) 
166 km/h (Moving Speed = 166 km/h) 
282 km/h (Moving Speed = 282 km/h) 
320 km/h (Moving Speed = 320 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.31 −1.0 
3 Rayleigh 0.71 −9.0 
4 Rayleigh 1.09 −10.0 
5 Rayleigh 1.73 −15.0 

6 Rayleigh 2.51 −20.0 
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Table B-5  HSUPA [3] 

Fading Profile Path Type Delay [us] Power [dB] 

Case1 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 −10.0 

Case2 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 0.976 0.0 

3 Rayleigh 20 0.0 

Case3 
92 km/h (Moving Speed = 92 km/h) 
120 km/h (Moving Speed = 120 km/h) 
166 km/h (Moving Speed = 166 km/h) 
280 km/h (Moving Speed = 280 km/h) 
320 km/h (Moving Speed = 320 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.26 −3.0 
3 Rayleigh 0.521 −6.0 

4 Rayleigh 0.781 −9.0 

Case4 
192 km/h (Moving Speed = 192 km/h) 
250 km/h (Moving Speed = 250 km/h) 
345 km/h (Moving Speed = 345 km/h) 
583 km/h (Moving Speed = 583 km/h) 
668 km/h (Moving Speed = 668 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.26 −3.0 
3 Rayleigh 0.521 −6.0 

4 Rayleigh 0.781 −9.0 

ITU Pedestrian A 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.11 −9.7 
3 Rayleigh 0.19 −19.2 

4 Rayleigh 0.41 −22.8 

ITU Pedestrian B 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 
4.1 km/h (Moving Speed = 4.1 km/h) 
7 km/h (Moving Speed = 7 km/h) 
8 km/h (Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.2 −0.9 
3 Rayleigh 0.8 −4.9 
4 Rayleigh 1.2 −8.0 
5 Rayleigh 2.3 −7.8 
6 Rayleigh 3.7 −23.9 

ITU Vehicular A 
23 km/h (Moving Speed = 23 km/h) 
30 km/h (Moving Speed = 30 km/h) 
41 km/h (Moving Speed = 41 km/h) 
71 km/h (Moving Speed = 71 km/h) 
80 km/h (Moving Speed = 80 km/h) 
92 km/h (Moving Speed = 92 km/h) 
120 km/h (Moving Speed = 120 km/h) 
166 km/h (Moving Speed = 166 km/h) 
282 km/h (Moving Speed = 282 km/h) 
320 km/h (Moving Speed = 320 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.31 −1.0 
3 Rayleigh 0.71 −9.0 
4 Rayleigh 1.09 −10.0 
5 Rayleigh 1.73 −15.0 

6 Rayleigh 2.51 −20.0 
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Table B-6  CDMA2000 (MS) [4] 

Fading Profile Path Type Delay [us] Power [dB] 

Case 1 
(Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 2.0 0.0 

Case 2 
14 km/h (Moving Speed = 14 km/h) 
30 km/h (Moving Speed = 30 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 2.0 0.0 

Case 3 
(Moving Speed = 30 km/h) 1 Rayleigh 0.0 0.0 

 

Case 4 
(Moving Speed = 100 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 2.0 0.0 
3 Rayleigh 14.5 −3.0 

Case 5 
(Moving Speed = 0 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 2.0 0.0 

Case 6 
(Moving Speed = 3 km/h) 1 Rayleigh 0.0 0.0 

 
 

Table B-7  CDMA2000 (BS) [5] 

Fading Profile Path Type Delay [us] Power [dB] 

Case 1 
(Moving Speed = 3 km/h) 1 Rayleigh 0.0 0.0 

Case 2 
(Moving Speed = 8 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 2.0 0.0 

Case 3 
(Moving Speed = 30 km/h) 1 Rayleigh 0.0 0.0 

Case 4 
(Moving Speed = 100 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 2.0 0.0 
3 Rayleigh 14.5 −3.0 
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Table B-8  TD-SCDMA [6] 

Fading Profile Path Type Delay [us] Power [dB] 

Case 1 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 2.928 −10.0 

Case 2 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 2.928 0.0 
3 Rayleigh 12.0 0.0 

Case 3 
92 km/h (Moving Speed = 92 km/h) 
120 km/h (Moving Speed = 120 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.781 −3.0 
3 Rayleigh 1.563 −6.0 
4 Rayleigh 2.344 −9.0 

ITU Pedestrian A 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.11 −9.7 
3 Rayleigh 0.19 −19.2 
4 Rayleigh 0.41 −22.8 

ITU Pedestrian B 
2.3 km/h (Moving Speed = 2.3 km/h) 
3 km/h (Moving Speed = 3 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.2 −0.9 
3 Rayleigh 0.8 −4.9 
4 Rayleigh 1.2 −8.0 
5 Rayleigh 2.3 −7.8 
6 Rayleigh 3.7 −23.9 

ITU Vehicular A 
23 km/h (Moving Speed = 23 km/h) 
30 km/h (Moving Speed = 30 km/h) 
92 km/h (Moving Speed = 92 km/h) 
120 km/h (Moving Speed = 120 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.31 −1.0 
3 Rayleigh 0.71 −9.0 
4 Rayleigh 1.09 −10.0 
5 Rayleigh 1.73 −15.0 
6 Rayleigh 2.51 −20.0 
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Table B-9  1xEVDO [7] 

Fading Profile Path Type Delay [us] Power [dB] 

Configuration 1 
8 km/h (Moving Speed = 8 km/h) 
15 km/h (Moving Speed = 15 km/h) 

1 Rayleigh 0.0 0.0 

2 Rayleigh 2.0 0.0 

Configuration 2 
3 km/h (Moving Speed = 3 km/h) 
6 km/h (Moving Speed = 6 km/h) 

1 Rayleigh 0.0 0.0 

Configuration 3 
30 km/h (Moving Speed = 30 km/h) 
58 km/h (Moving Speed = 58 km/h) 

1 Rayleigh 0.0 0.0 

Configuration 4 
100 km/h (Moving Speed = 100 km/h) 
192 km/h (Moving Speed = 192 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 2.0 0.0 
3 Rayleigh 14.5 −3.0 

Configuration 5 
(Moving Speed = 0 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 2.0 −0.0 
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Table B-10  WLAN [8] 

Fading Profile Path Type Delay [us] Power [dB] 

Model A  
(Moving Speed = 10.8 km/h) 

1 Rayleigh 0.000 0.0 
2 Rayleigh 0.010 −0.9 
3 Rayleigh 0.020 −1.7 
4 Rayleigh 0.030 −2.6 
5 Rayleigh 0.040 −3.5 
6 Rayleigh 0.050 −4.3 
7 Rayleigh 0.060 −5.2 
8 Rayleigh 0.070 −6.1 
9 Rayleigh 0.080 −6.9 

10 Rayleigh 0.090 −7.8 
11 Rayleigh 0.110 −4.7 
12 Rayleigh 0.140 −7.3 
13 Rayleigh 0.170 −9.9 
14 Rayleigh 0.200 −12.5 
15 Rayleigh 0.240 −13.7 
16 Rayleigh 0.290 −18.0 
17 Rayleigh 0.340 −22.4 
18 Rayleigh 0.390 −26.7 

Model B 
(Moving Speed = 10.8 km/h) 

1 Rayleigh 0.000 −2.6 
2 Rayleigh 0.010 −3.0 
3 Rayleigh 0.020 −3.5 
4 Rayleigh 0.030 −3.9 
5 Rayleigh 0.050 0.0 
6 Rayleigh 0.080 −1.3 
7 Rayleigh 0.110 −2.6 
8 Rayleigh 0.140 −3.9 
9 Rayleigh 0.180 −3.4 

10 Rayleigh 0.230 −5.6 
11 Rayleigh 0.280 −7.7 
12 Rayleigh 0.330 −9.9 
13 Rayleigh 0.380 −12.1 
14 Rayleigh 0.430 −14.3 
15 Rayleigh 0.490 −15.4 
16 Rayleigh 0.560 −18.4 
17 Rayleigh 0.640 −20.7 
18 Rayleigh 0.730 −24.6 
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Table B-10  WLAN [8] (Cont’d) 

Fading Profile Path Type Delay [us] Power [dB] 

Model C 
(Moving Speed = 10.8 km/h) 

1 Rayleigh 0.000 −3.3 
2 Rayleigh 0.010 −3.6 
3 Rayleigh 0.020 −3.9 
4 Rayleigh 0.030 −4.2 
5 Rayleigh 0.050 0.0 
6 Rayleigh 0.080 −0.9 
7 Rayleigh 0.110 −1.7 
8 Rayleigh 0.140 −2.6 
9 Rayleigh 0.180 −1.5 

10 Rayleigh 0.230 −3.0 
11 Rayleigh 0.280 −4.4 
12 Rayleigh 0.330 −5.9 
13 Rayleigh 0.400 −5.3 
14 Rayleigh 0.490 −7.9 
15 Rayleigh 0.600 −9.4 
16 Rayleigh 0.730 −13.2 
17 Rayleigh 0.880 −16.3 
18 Rayleigh 1.050 −21.2 

Model D 
(Moving Speed = 10.8 km/h) 

1 Rayleigh 0.000 0.0 
2 Rayleigh 0.010 −10.0 
3 Rayleigh 0.020 −10.3 
4 Rayleigh 0.030 −10.6 
5 Rayleigh 0.050 −6.4 
6 Rayleigh 0.080 −7.2 
7 Rayleigh 0.110 −8.1 
8 Rayleigh 0.140 −9.0 
9 Rayleigh 0.180 −7.9 

10 Rayleigh 0.230 −9.4 
11 Rayleigh 0.280 −10.8 
12 Rayleigh 0.330 −12.3 
13 Rayleigh 0.400 −11.7 
14 Rayleigh 0.490 −14.3 
15 Rayleigh 0.600 −15.8 
16 Rayleigh 0.730 −19.6 
17 Rayleigh 0.880 −22.7 
18 Rayleigh 1.050 −27.6 
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Table B-10  WLAN [8] (Cont’d) 

Fading Profile Path Type Delay [us] Power [dB] 

Model E 
(Moving Speed = 10.8 km/h) 

1 Rayleigh 0.000 −4.9 
2 Rayleigh 0.010 −5.1 
3 Rayleigh 0.020 −5.2 
4 Rayleigh 0.040 −0.8 
5 Rayleigh 0.070 −1.3 
6 Rayleigh 0.100 −1.9 
7 Rayleigh 0.140 −0.3 
8 Rayleigh 0.190 −1.2 
9 Rayleigh 0.240 −2.1 

10 Rayleigh 0.320 0.0 
11 Rayleigh 0.430 −1.9 
12 Rayleigh 0.560 −2.8 
13 Rayleigh 0.710 −5.4 
14 Rayleigh 0.880 −7.3 
15 Rayleigh 1.070 −10.6 
16 Rayleigh 1.280 −13.4 
17 Rayleigh 1.510 −17.4 
18 Rayleigh 1.760 −20.9 
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Table B-11  Mobile WiMAX [9] 

Fading Profile Path Type Delay [us] Power [dB] 

ITU Pedestrian B 
(Moving Speed 3 = km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.2 −0.9 
3 Rayleigh 0.8 −4.9 
4 Rayleigh 1.2 −8.0 
5 Rayleigh 2.3 −7.8 
6 Rayleigh 3.7 −23.9 

ITU Vehicular A 
(Moving Speed = 60 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.31 −1.0 
3 Rayleigh 0.71 −9.0 
4 Rayleigh 1.09 −10.0 
5 Rayleigh 1.73 −15.0 
6 Rayleigh 2.51 −20.0 

Large delay spread channel 
(Moving Speed = 120 km/h) 

1 Rayleigh 0.0 0.0 
2 Rayleigh 0.31 −1.0 
3 Rayleigh 0.71 −9.0 
4 Rayleigh 1.09 −10.0 
5 Rayleigh 1.73 −15.0 
6 Rayleigh 10.0 −20.0 
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Table B-12  2 × 2 MIMO Mobile WiMAX [9] 

Correlation Matrix (2 × 2 MIMO)  ITU Pedestrian B  3km/h 

High 
correlation 

Path 1 Channel 1 Channel 2 Channel 3 Channel 4 
Channel 1 1.00000 −0.1468 + 0.4156i 0.0303 + 0.7064i −0.298 − 0.09111i 
Channel 2 −0.1468 − 0.4156i 1.00000 0.28913 − 0.11629i 0.0303 + 0.7064i 
Channel 3 0.0303 − 0.7064i 0.28913 + 0.11629i 1.00000 −0.1468 + 0.4156i 
Channel 4 −0.29803 + 0.09111i 0.0303 − 0.7064i −0.1468 − 0.4156i 1.00000 

     
Path 2 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 −0.4467 + 0.4227i −0.4007 − 0.6073i 0.4357 + 0.10191i 
Channel 2 −0.4467 − 0.4227i 1.00000 −0.07771 − 0.44066i −0.4007 − 0.6073i 
Channel 3 −0.4007 + 0.6073i −0.07771 − 0.44066i 1.00000 −0.4467 + 0.4227i 
Channel 4 0.4357 − 0.10191i −0.4007 + 0.6073i −0.4467 − 0.4227i 1.00000 

     
Path 3 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 −0.2906 + 0.4347i −0.6664 + 0.262i 0.07976 − 0.36582i 
Channel 2 −0.2906 − 0.4347i 1.00000 0.30755 + 0.21355i −0.6664 + 0.262i 
Channel 3 −0.6664 − 0.262i 0.30755 − 0.21355i 1.00000 −0.2906 + 0.4347i 
Channel 4 0.07976 + 0.36582i −0.6664 − 0.262i −0.2906 − 0.4347i 1.00000 

     
Path 4 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 −0.4273 + 0.4259i −0.6522 + 0.2088i 0.18976 − 0.367i 
Channel 2 −0.4273 − 0.4259i 1.00000 0.36761 + 0.18855i −0.6522 + 0.2088i 
Channel 3 −0.6522 − 0.2088i 0.36761 − 0.18855i 1.00000 −0.4273 + 0.4259i 
Channel 4 0.18976 + 0.367i −0.6522 − 0.2088i −0.4273 − 0.4259i 1.00000 

     
Path 5 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 −0.7026 − 0.3395i −0.5378 − 0.4866i 0.21266 + 0.52447i 
Channel 2 −0.7026 + 0.3395i 1.00000 0.54306 + 0.1593i −0.5378 − 0.4866i 
Channel 3 −0.5378 + 0.4866i 0.54306 − 0.1593i 1.00000 −0.7026 − 0.3395i 
Channel 4 0.21266 − 0.52447i −0.5378 + 0.4866i −0.7026 + 0.3395i 1.00000 

     
Path 6 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 −0.45 + 0.4222 i −0.4564 − 0.5655i 0.44413 + 0.06178i 
Channel 2 −0.45 − 0.422i 1.00000 −0.03337 + 0.44717i −0.4564 − 0.5655i 
Channel 3 −0.4564 + 0.5655i −0.03337 − 0.44717i 1.00000 −0.45 + 0.4222i 
Channel 4 0.44413 − 0.06178i −0.4564 + 0.5655i −0.45 − 0.4222i 1.00000 
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Table B-12  2 × 2 MIMO Mobile WiMAX [9] (Cont’d) 

Correlation Matrix (2 × 2 MIMO)  ITU Pedestrian B  3km/h 

Medium 
correlation 

Path 1 to 
Path 6 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.00000 0.7264 0.00000 
Channel 2 0.00000 1.00000 0.00000 −0.7264 
Channel 3 0.7264 0.00000 1.00000 0.00000 
Channel 4 0.00000 −0.7264 0.00000 1.00000 

Low 
correlation 

Path 1 Channel 1 Channel 2 Channel 3 Channel 4 
Channel 1 1.00000 0.00000 0.02201 + 0.51313i 0.00000 
Channel 2 0.00000 1.00000 0.0000 −0.02201 − 0.51313i 
Channel 3 0.02201 − 0.51313i 0.00000 1.00000 0.00000 
Channel 4 0.00000 −0.02201 + 0.51313i 0.00000 1.00000 

     
Path 2 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.0000 0.0000 −0.29107 − 0.44114i 0.0000 
Channel 2 0.0000 1.0000 0.0000 0.29107 + 0.44114i 
Channel 3 −0.29107 + 0.44114i 0.0000 1.0000 0.0000 
Channel 4 0.0000 0.29107 − 0.44114i 0.0000 1.0000 

     
Path 3 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.00000 −0.48407 + 0.19032i 0.00000 
Channel 2 0.00000 1.00000 0.00000 0.48407 − 0.19032i 
Channel 3 −0.48407 − 0.19032i 0.00000 1.00000 0.00000 
Channel 4 0.00000 0.48407 + 0.19032i 0.00000 1.00000 

     
Path 4 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.00000 −0.47376 + 0.15167i 0.00000 
Channel 2 0.00000 1.00000 0.00000 0.47376 − 0.15167i 
Channel 3 −0.47376 − 0.15167i 0.00000 1.00000 0.00000 
Channel 4 0.00000 0.47376 + 0.15167i 0.00000 1.00000 

     
Path 5 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.00000 −0.39066 − 0.35347i 0.00000 
Channel 2 0.00000 1.00000 0.00000 0.39066 + 0.35347i 
Channel 3 −0.39066 + 0.35347i 0.00000 1.00000 0.00000 
Channel 4 0.00000 0.39066 − 0.35347i 0.00000 1.00000 

     
Path 6 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.00000 −0.33153 − 0.41078i 0.00000 
Channel 2 0.00000 1.00000 0.00000 0.33153 + 0.41078i 
Channel 3 −0.33153 + 0.41078i 0.00000 1.00000 0.00000 
Channel 4 0.00000 0.33153 − 0.41078i 0.00000 1.00000 
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Table B-12  2 × 2 MIMO Mobile WiMAX [9] (Cont’d) 

Correlation Matrix (2 × 2 MIMO)  ITU Vehicular A  60km/h, Large delay spread channel 

High 
correlation 

Path 1 Channel 1 Channel 2 Channel 3 Channel 4 
Channel 1 1.00000 −0.2366 + 0.4312i 0.6883 + 0.1211i −0.21507 − 0.26814i 
Channel 2 −0.2366 − 0.4312i 1.00000 −0.11063 − 0.32544i 0.6883 + 0.1211i 
Channel 3 0.6883 − 0.1211i −0.11063 + 0.32544i 1.00000 −0.2366 + 0.4312i 
Channel 4 −0.21507 + 0.26814i 0.6883 − 0.1211i −0.2366 − 0.4312i 1.00000 

     
Path 2 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.1388 + 0.2343i −0.3508 − 0.5926i 0.09016 + 0.16445i 
Channel 2 0.1388 − 0.2343i 1.00000 −0.1875 − 0.00006i −0.3508 − 0.5926i 
Channel 3 −0.3508 + 0.5926i −0.18754 + 0.00006i 1.00000 0.1388 + 0.2343i 
Channel 4 0.09016 + 0.16445i −0.3508 + 0.5926i 0.1388 − 0.2343i 1.00000 

     
Path 3 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 −0.6443 + 0.365i 0.3884 − 0.5604i −0.0457 + 0.50283i 
Channel 2 −0.6443 − 0.365i 1.00000 −0.45479 + 0.2193i 0.3884 − 0.5604i 
Channel 3 0.3884 + 0.5604i −0.45479 − 0.2193i 1.00000 −0.6443 + 0.365i 
Channel 4 −0.0457 − 0.50283i 0.3884 + 0.5604i −0.6443 − 0.365i 1.00000 

     
Path 4 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 −0.362 + 0.4331i 0.1899 + 0.6795i −0.36304 − 0.16373i 
Channel 2 −0.362 − 0.4331i 1.00000 0.22555 − 0.32823i 0.1899 + 0.6795i 
Channel 3 0.1899 − 0.6795i 0.22555 + 0.32823i 1.00000 −0.362 + 0.4331i 
Channel 4 −0.36304 + 0.16373i 0.1899 − 0.6795i −0.362 − 0.4331i 1.00000 

     
Path 5 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 −0.7074 + 0.3372i −0.3933 − 0.565i 0.46874 + 0.26706i 
Channel 2 −0.7074 − 0.3372i 1.00000 0.0877 + 0.5323i −0.3933 − 0.565i 
Channel 3 −0.3933 + 0.565i 0.0877 − 0.5323i 1.00000 −0.7074 + 0.3372i 
Channel 4 0.46874 − 0.26706i −0.3933 + 0.565i −0.7074 − 0.3372i 1.00000 

     
Path 6 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 −0.4405 + 0.4238i −0.4383 − 0.58i 0.43888 + 0.06974i 
Channel 2 −0.4405 − 0.4238i 1.00000 −0.05273 + 0.44124i −0.4383 − 0.58i 
Channel 3 −0.4383 + 0.58i −0.05273 − 0.44124i 1.00000 −0.4405 + 0.4238i 
Channel 4 0.43888 − 0.06974i −0.4383 + 0.58i −0.4405 − 0.4238i 1.00000 
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Table B-12  2 × 2 MIMO Mobile WiMAX (Cont’d) 

Correlation Matrix (2 × 2 MIMO)  ITU Vehicular A  60km/h, Large delay spread channel 

Medium 
correlation 

Path 1 to 
Path 6 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.00000 0.7264 0.00000 
Channel 2 0.00000 1.00000 0.00000 −0.7264 
Channel 3 0.7264 0.00000 1.00000 0.00000 
Channel 4 0.00000 −0.7264 0.00000 1.00000 

Low 
correlation 

Path 1 Channel 1 Channel 2 Channel 3 Channel 4 
Channel 1 1.00000 0.00000 0.49998 + 0.08797i 0.00000 
Channel 2 0.00000 1.00000 0.00000 −0.49998 − 0.08797i 
Channel 3 0.49998 − 0.08797i 0.00000 1.00000 0.00000 
Channel 4 0.00000 −0.49998 + 0.08797i 0.00000 1.00000 

     
Path 2 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.00000 −0.25482 − 0.43046i 0.00000 
Channel 2 0.00000 1.00000 0.00000 0.25482 + 0.43046i 
Channel 3 −0.25482 + 0.43046i 0.00000 1.00000 0.00000 
Channel 4 0.00000 0.25482 − 0.43046i 0.00000 1.00000 

     
Path 3 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.00000 0.28213 − 0.40707i 0.00000 
Channel 2 0.00000 1.00000 0.00000 −0.28213 + 0.40707i 
Channel 3 0.28213 + 0.40707i 0.00000 1.00000 0.00000 
Channel 4 0.00000 −0.28213 − 0.40707i 0.00000 1.00000 

     
Path 4 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.0000 0.0000 0.13794 + 0.49359i 0.0000 
Channel 2 0.0000 1.0000 0.0000 −0.13794 − 0.49359i 
Channel 3 0.13794 − 0.49359i 0.0000 1.0000 0.0000 
Channel 4 0.0000 −0.13794 + 0.49359i 0.0000 1.0000 

     
Path 5 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.00000 0.00000 −0.28569 − 0.41042i 0.00000 
Channel 2 0.00000 1.00000 0.00000 0.28569 + 0.41042i 
Channel 3 −0.28569 + 0.41042i 0.00000 1.00000 0.00000 
Channel 4 0.00000 0.28569 − 0.41042i 0.00000 1.00000 

     
Path 6 Channel 1 Channel 2 Channel 3 Channel 4 

Channel 1 1.0000 0.0000 −0.31838 − 0.42131i 0.0000 
Channel 2 0.0000 1.0000 0.0000 0.31838 + 0.42131i 
Channel 3 −0.31838 + 0.42131i 0.0000 1.0000 0.0000 
Channel 4 0.0000 0.31838 − 0.42131i 0.0000 1.0000 
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Table B-13  DVB-T [10] 

Fading Profile Path Type Delay [us] Power [dB] 

Typical Urban (TU6) 

1 Rayleigh 0.0 −3.0 
2 Rayleigh 0.2 0.0 
3 Rayleigh 0.5 −2.0 
4 Rayleigh 1.6 −6.0 
5 Rayleigh 2.3 −8.0 
6 Rayleigh 5.0 −10.0 

Typical Rural Area (RA6) 

1 Rice 0.0 0.0 
2 Rayleigh 0.1 −4.0 
3 Rayleigh 0.2 −8.0 
4 Rayleigh 0.3 −12.0 
5 Rayleigh 0.4 −16.0 
6 Rayleigh 0.5 −20.0 

 



 

Appendix B  Fading Profile Details 

B-21 

A
ppendix 

A
ppendix B 

 

Table B-14  LTE （MS）（BS） [11] [12] 

Fading Profile Path Type Delay [us] Power [dB] 

Extended Pedestrian A (EPA) 

1 Rayleigh 0.00 0.0 
2 Rayleigh 0.03 −1.0 
3 Rayleigh 0.07 −2.0 
4 Rayleigh 0.09 −3.0 
5 Rayleigh 0.11 −8.0 
6 Rayleigh 0.19 −17.2 
7 Rayleigh 0.41 −20.8 

Extended Vehicular A (EVA) 

1 Rayleigh 0.00 0.0 
2 Rayleigh 0.03 −1.5 
3 Rayleigh 0.15 −1.4 
4 Rayleigh 0.31 −3.6 
5 Rayleigh 0.37 −0.6 
6 Rayleigh 0.71 −9.1 
7 Rayleigh 1.09 −7.0 
8 Rayleigh 1.73 −12.0 
9 Rayleigh 2.51 −16.9 

Extended Typical Urban 

1 Rayleigh 0.00 −1.0 
2 Rayleigh 0.05 −1.0 
3 Rayleigh 0.12 −1.0 
4 Rayleigh 0.20 0.0 
5 Rayleigh 0.23 0.0 
6 Rayleigh 0.50 0.0 
7 Rayleigh 1.6 −3.0 
8 Rayleigh 2.3 −5.0 
9 Rayleigh 5.0 −7.0 

High Speed Train Refer to 3.1.6 “High Speed Train tab window.”  
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Table B-15  2 × 2 MIMO LTE [11] [12] 

Correlation Matrix( 1x2 SIMO ) 
R_high 
 

 Channel 1 Channel 2 
Channel 1 1.0 0.9 
Channel 2 0.9 1.0 

R_low  Channel 1 Channel 2 
Channel 1 1.0 0.0 
Channel 2 0.0 1.0 

 

Table B-15  2 × 2 MIMO LTE [11] [12] (Cont’d) 

Correlation Matrix (2 × 2 MIMO) 

R_high  Channel 1 Channel 2 Channel 3 Channel 4 
Channel 1 1.0 0.9 0.9 0.81 
Channel 2 0.9 1.0 0.81 0.9 
Channel 3 0.9 0.81 1.0 0.9 
Channel 4 0.81 0.9 0.9 1.0 

R_medium  Channel 1 Channel 2 Channel 3 Channel 4 
Channel 1 1.0 0.9 0.3 0.27 
Channel 2 0.9 1.0 0.27 0.3 
Channel 3 0.3 0.27 1.0 0.9 
Channel 4 0.27 0.3 0.9 1.0 

R_low  Channel 1 Channel 2 Channel 3 Channel 4 
Channel 1 1.0 0.0 0.0 0.0 
Channel 2 0.0 1.0 0.0 0.0 
Channel 3 0.0 0.0 1.0 0.0 
Channel 4 0.0 0.0 0.0 1.0 
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Table B-15  MIMO LTE [11][12] (Cont’d) 

Correlation Matrix( 4x2 MIMO ) 

R_ 
high 
 

 Ch1 Ch2 Ch3 Ch4 Ch5 Ch6 Ch7 Ch8 
Ch1 1 0.8999 0.9883 0.8894 0.9542 0.8587 0.8999 0.8099 
Ch2 0.8999 1 0.8894 0.9883 0.8587 0.9542 0.8099 0.8999 
Ch3 0.9883 0.8894 1 0.8999 0.9883 0.8894 0.9542 0.8587 
Ch4 0.8894 0.9883 0.8999 1 0.8894 0.9883 0.8587 0.9542 
Ch5 0.9542 0.8587 0.9883 0.8894 1 0.8999 0.9883 0.8894 
Ch6 0.8587 0.9542 0.8894 0.9883 0.8999 1 0.8894 0.9883 
Ch7 0.8999 0.8099 0.9542 0.8587 0.9883 0.8894 1 0.8999 
Ch8 0.8099 0.8999 0.8587 0.9542 0.8894 0.9883 0.8999 1 

R_me
dium 
 

 Ch1 Ch2 Ch3 Ch4 Ch5 Ch6 Ch7 Ch8 
Ch1 1 0.9 0.8748 0.7873 0.5856 0.5271 0.3 0.27 
Ch2 0.9 1 0.7873 0.8748 0.5271 0.5856 0.27 0.3 
Ch3 0.8748 0.7873 1 0.9 0.8748 0.7873 0.5856 0.5271 
Ch4 0.7873 0.8748 0.9 1 0.7873 0.8748 0.5271 0.5856 
Ch5 0.5856 0.5271 0.8748 0.7873 1 0.9 0.8748 0.7873 
Ch6 0.5271 0.5856 0.7873 0.8748 0.9 1 0.7873 0.8748 
Ch7 0.3 0.27 0.5856 0.5271 0.8748 0.7873 1 0.9 
Ch8 0.27 0.3 0.5271 0.5856 0.7873 0.8748 0.9 1 

R_low  Ch1 Ch2 Ch3 Ch4 Ch5 Ch6 Ch7 Ch8 

 Ch1 1 0 0 0 0 0 0 0 
 Ch2 0 1 0 0 0 0 0 0 
 Ch3 0 0 1 0 0 0 0 0 
 Ch4 0 0 0 1 0 0 0 0 
 Ch5 0 0 0 0 1 0 0 0 
 Ch6 0 0 0 0 0 1 0 0 
 Ch7 0 0 0 0 0 0 1 0 
 Ch8 0 0 0 0 0 0 0 1 
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Table B-15  MIMO LTE [11][12] (Cont’d) 

Correlation Matrix( 4x4 MIMO ) 

R_ 
high 

 Ch1 Ch2 Ch3 Ch4 Ch5 Ch6 Ch7 Ch8 

 Ch1 1 0.9882 0.9541 0.8999 0.9882 0.9767 0.943 0.8894 
 Ch2 0.9882 1 0.9882 0.9541 0.9767 0.9882 0.9767 0.943 
 Ch3 0.9541 0.9882 1 0.9882 0.943 0.9767 0.9882 0.9767 
 Ch4 0.8999 0.9541 0.9882 1 0.8894 0.943 0.9767 0.9882 
 Ch5 0.9882 0.9767 0.943 0.8894 1 0.9882 0.9541 0.8999 
 Ch6 0.9767 0.9882 0.9767 0.943 0.9882 1 0.9882 0.9541 
 Ch7 0.943 0.9767 0.9882 0.9767 0.9541 0.9882 1 0.9882 
 Ch8 0.8894 0.943 0.9767 0.9882 0.8999 0.9541 0.9882 1 
 Ch9 0.9541 0.943 0.9105 0.8587 0.9882 0.8999 0.9541 0.9882 
 Ch10 0.943 0.9541 0.943 0.9105 0.9767 0.9882 0.9767 0.943 
 Ch11 0.9105 0.943 0.9541 0.943 0.943 0.9767 0.9882 0.9767 
 Ch12 0.8587 0.9105 0.943 0.9541 0.8894 0.943 0.9767 0.9882 
 Ch13 0.8999 0.8894 0.8587 0.8099 0.9541 0.943 0.9105 0.8587 
 Ch14 0.8894 0.8999 0.8894 0.8587 0.943 0.9541 0.943 0.9105 
 Ch15 0.8587 0.8894 0.8999 0.8894 0.9105 0.943 0.9541 0.943 
 Ch16 0.8099 0.8587 0.8894 0.8999 0.8587 0.9105 0.943 0.9541 
  Ch9 Ch10 Ch11 Ch12 Ch13 Ch14 Ch15 Ch16 
 Ch1 0.9541 0.943 0.9105 0.8587 0.8999 0.8894 0.8587 0.8099 
 Ch2 0.943 0.9541 0.943 0.9105 0.8894 0.8999 0.8894 0.8587 
 Ch3 0.9105 0.943 0.9541 0.943 0.8587 0.8894 0.8999 0.8894 
 Ch4 0.8587 0.9105 0.943 0.9541 0.8099 0.8587 0.8894 0.8999 
 Ch5 0.9882 0.9767 0.943 0.8894 0.9541 0.943 0.9105 0.8587 
 Ch6 0.8999 0.9882 0.9767 0.943 0.943 0.9541 0.943 0.9105 
 Ch7 0.9541 0.9767 0.9882 0.9767 0.9105 0.943 0.9541 0.943 
 Ch8 0.9882 0.943 0.9767 0.9882 0.8587 0.9105 0.943 0.9541 
 Ch9 1 0.9882 0.9541 0.8999 0.9882 0.9767 0.943 0.8894 
 Ch10 0.9882 1 0.9882 0.9541 0.9767 0.9882 0.9767 0.943 
 Ch11 0.9541 0.9882 1 0.9882 0.943 0.9767 0.9882 0.9767 
 Ch12 0.8999 0.9541 0.9882 1 0.8894 0.943 0.9767 0.9882 
 Ch13 0.9882 0.9767 0.943 0.8894 1 0.9882 0.9541 0.8999 
 Ch14 0.9767 0.9882 0.9767 0.943 0.9882 1 0.9882 0.9541 
 Ch15 0.943 0.9767 0.9882 0.9767 0.9541 0.9882 1 0.9882 
 Ch16 0.8894 0.943 0.9767 0.9882 0.8999 0.9541 0.9882 1 
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Table B-15  MIMO LTE [11][12] (Cont’d) 

Correlation Matrix( 4x4 MIMO ) 
R_medi
um 

 Ch1 Ch2 Ch3 Ch4 Ch5 Ch6 Ch7 Ch8 

 Ch1 1 0.9882 0.9541 0.8999 0.8747 0.8645 0.8347 0.7872 
 Ch2 0.9882 1 0.9882 0.9541 0.8645 0.8747 0.8645 0.8347 
 Ch3 0.9541 0.9882 1 0.9882 0.8347 0.8645 0.8747 0.8645 
 Ch4 0.8999 0.9541 0.9882 1 0.7872 0.8347 0.8645 0.8747 
 Ch5 0.8747 0.8645 0.8347 0.7872 1 0.9882 0.9541 0.8999 
 Ch6 0.8645 0.8747 0.8645 0.8347 0.9882 1 0.9882 0.9541 
 Ch7 0.8347 0.8645 0.8747 0.8645 0.9541 0.9882 1 0.9882 
 Ch8 0.7872 0.8347 0.8645 0.8747 0.8999 0.9541 0.9882 1 
 Ch9 0.5855 0.5787 0.5588 0.527 0.8747 0.8645 0.8347 0.7872 
 Ch10 0.5787 0.5855 0.5787 0.5588 0.8645 0.8747 0.8645 0.8347 
 Ch11 0.5588 0.5787 0.5855 0.5787 0.8347 0.8645 0.8747 0.8645 
 Ch12 0.527 0.5588 0.5787 0.5855 0.7872 0.8347 0.8645 0.8747 
 Ch13 0.3 0.2965 0.2862 0.27 0.5855 0.5787 0.5588 0.527 
 Ch14 0.2965 0.3 0.2965 0.2862 0.5787 0.5855 0.5787 0.5588 
 Ch15 0.2862 0.2965 0.3 0.2965 0.5588 0.5787 0.5855 0.5787 
 Ch16 0.27 0.2862 0.2965 0.3 0.527 0.5588 0.5787 0.5855 
  Ch9 Ch10 Ch11 Ch12 Ch13 Ch14 Ch15 Ch16 

 Ch1 0.5855 0.5787 0.5588 0.527 0.3 0.2965 0.2862 0.27 
 Ch2 0.5787 0.5855 0.5787 0.5588 0.2965 0.3 0.2965 0.2862 
 Ch3 0.5588 0.5787 0.5855 0.5787 0.2862 0.2965 0.3 0.2965 
 Ch4 0.527 0.5588 0.5787 0.5855 0.27 0.2862 0.2965 0.3 
 Ch5 0.8747 0.8645 0.8347 0.7872 0.5855 0.5787 0.5588 0.527 
 Ch6 0.8645 0.8747 0.8645 0.8347 0.5787 0.5855 0.5787 0.5588 
 Ch7 0.8347 0.8645 0.8747 0.8645 0.5588 0.5787 0.5855 0.5787 
 Ch8 0.7872 0.8347 0.8645 0.8747 0.527 0.5588 0.5787 0.5855 
 Ch9 1 0.9882 0.9541 0.8999 0.8747 0.8645 0.8347 0.7872 
 Ch10 0.9882 1 0.9882 0.9541 0.8645 0.8747 0.8645 0.8347 
 Ch11 0.9541 0.9882 1 0.9882 0.8347 0.8645 0.8747 0.8645 
 Ch12 0.8999 0.9541 0.9882 1 0.7872 0.8347 0.8645 0.8747 
 Ch13 0.8747 0.8645 0.8347 0.7872 1 0.9882 0.9541 0.8999 
 Ch14 0.8645 0.8747 0.8645 0.8347 0.9882 1 0.9882 0.9541 
 Ch15 0.8347 0.8645 0.8747 0.8645 0.9541 0.9882 1 0.9882 
 Ch16 0.7872 0.8347 0.8645 0.8747 0.8999 0.9541 0.9882 1 
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Table B-15  MIMO LTE [11][12] (Cont’d) 

Correlation Matrix( 4x4 MIMO ) 

R_ 
low 

 

 Ch1 Ch2 Ch3 Ch4 Ch5 Ch6 Ch7 Ch8 
Ch1 1 0 0 0 0 0 0 0 
Ch2 0 1 0 0 0 0 0 0 
Ch3 0 0 1 0 0 0 0 0 
Ch4 0 0 0 1 0 0 0 0 

 Ch5 0 0 0 0 1 0 0 0 
 Ch6 0 0 0 0 0 1 0 0 
 Ch7 0 0 0 0 0 0 1 0 
 Ch8 0 0 0 0 0 0 0 1 
 Ch9 0 0 0 0 0 0 0 0 
 Ch10 0 0 0 0 0 0 0 0 
 Ch11 0 0 0 0 0 0 0 0 
 Ch12 0 0 0 0 0 0 0 0 
 Ch13 0 0 0 0 0 0 0 0 
 Ch15 0 0 0 0 0 0 0 0 
 Ch16 0 0 0 0 0 0 0 0 
  Ch9 Ch10 Ch11 Ch12 Ch13 Ch14 Ch15 Ch16 
 Ch1 0 0 0 0 0 0 0 0 
 Ch2 0 0 0 0 0 0 0 0 
 Ch3 0 0 0 0 0 0 0 0 
 Ch4 0 0 0 0 0 0 0 0 
 Ch5 0 0 0 0 0 0 0 0 
 Ch6 0 0 0 0 0 0 0 0 
 Ch7 0 0 0 0 0 0 0 0 
 Ch8 0 0 0 0 0 0 0 0 
 Ch9 1 0 0 0 0 0 0 0 
 Ch10 0 1 0 0 0 0 0 0 
 Ch11 0 0 1 0 0 0 0 0 
 Ch12 0 0 0 1 0 0 0 0 
 Ch13 0 0 0 0 1 0 0 0 
 Ch14 0 0 0 0 0 1 0 0 
 Ch15 0 0 0 0 0 0 1 0 
 Ch16 0 0 0 0 0 0 0 1 
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Reference 
[1] 3GPP TS 45.005 V7.9.0 (2007-02) Annex C 

[2] 3GPP TS34.121 V8.1.0 (2007-12) Annex D 

[3] 3GPP TS25.141 V8.2.0 (2008-03) Annex D 

[4] 3GPP2 C.S0011-C v2.0 

[5] 3GPP2 C.S0010-C v2.0 

[6] 3GPP TS 25.102 V7.7.0 (2007-06) Annex B 

[7] 3GPP2 C.S0032-A v1.0 

[8] “Channel model for HiperLAN/2 in different indoor scenarios,” ETSI 
EP BRAN 3ERI085B, March 1998. 

[9] WiMAX Forum Mobile RCT-Wave2 (2007-12) 

[10] ETSI TR 101 290 V1.2.1 (2001-05) 

[11] 3GPP TR 36.803 V1.0.0 (2007-12) 

[12] 3GPP TR 36.804 V1.0.0 (2007-11) 
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A different RF signal must be separately input to two Rx antenna input 
connectors to implement a 2  2 MIMO configuration. 

There are two ways to synchronize signals when connecting multiple 
MG3700A, MG3710A or MG3740A units. One is to use an external 
Start/Frame Trigger, the other is to use one 
MG3700A/MG3710A/MG3740A unit as Primary and a second 
MG3700A/MG3710A/MG3740A unit as Secondary. 

C.1 Connecting Multiple MG3700As 
Using external Start/Frame Trigger 

In this method, signals are synchronized by supplying an external 
Start/Frame Trigger to multiple MG3700A units. . Fig. C.1-1 shows a 
connection diagram. 

Start/Frame Trigger

10 MHz buffered output

DUT 

Antenna 1 Antenna 2 

MG3700A#1 MG3700A#2 

Start/Frame Trigger

10 MHz reference input

Pulse Generator (TTL) 

 

Figure C.1-1  Multiple MG3700A connection (external Start/Frame Trigger) 

 

Synchronizing baseband signals 

Input a TTL-level pulse signal to the Start/Frame Trigger connector on 
the MG3700A #1 as well as the MG3700A #2. 
Next, configure the settings as follows for these two MG3700A units. 

Start/Frame Trigger: 
Trigger = ON 
Mode = Start 
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Synchronization between baseband signals is established within one 
sampling clock of the waveform pattern with Delay = 0 (excluding an 
external cable delay error). . Fig. C-2 shows the synchronization 
relationship of the two signal generators. . Sampling clock a is 
determined by the sampling rate of the waveform pattern that is 
generated. 

When the sampling rate is 20 MHz or lower: 

a = sampling rate  2  (n is a value where 80M  a  160M) 

When the sampling rate is higher than 20 MHz: 

a = sampling rate 

Note that the delay adjustment resolution changes, depending on the 
sampling rate. Refer to the following for details. 

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.5.3 “Setting up external input/output” 

 
The MG3700A waits for the trigger to be input once the Waveform 
Restart function key is pressed. . Input the trigger after both of the 
MG3700A units are in this state.  

Synchronizing RF signals 

The RF frequencies of the two MG3700A units are synchronized using a 
10 MHz reference clock. 
Modify the Phase Adjust setting of either unit when changing the phase 
relation of the RF signal. 

Start/Frame Trigger 

< 1 sampling clock 

MG3700A#1 Output 

MG3700A#2 Output 

 

Figure C.1-2  Synchronization-baseband signals when using external 

Start/Frame Trigger 

n 
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Using Primary/Secondary 

In this method, signals are synchronized by sending a Start/Frame 
Trigger from the Primary to Secondary, where MG3700A#1 is the 
Primary and MG3700A#2 is the Secondary. Primary and Secondary must 
be set when generating waveforms, before the waveform patterns can be 
used, because the waveform pattern that is output from the MG3700A 
set as the Secondary side produces a one frame lag to the Primary side 
when Delay = 0. For the MX370107A on the Primary side, set SG 
Primary/Secondary Setting to Primary and select Pattern Sync Marker 
from Marker 1 to Marker 3, as shown in Fig. C-3. For the Secondary side, 
SG Primary/Secondary Setting is automatically set to Secondary. 

 

Figure C.1-3  Setting example of Primary side 

 

Fig. C.1-4 shows the connection, and Fig. C.1-5 shows the 
synchronization relationship of the two signal generators. Compared to 
the method using an external Start/Frame Trigger, the synchronization 
error between the Primary output and Pattern Sync Marker is greater 
when using Primary/Secondary. Refer to the following manual(s) for 
details on the operation when the Start/Frame trigger is input.  

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.5.4 “To output the signal in synchronization with the external 
trigger signal.” 

 

 
 

 SG Primary/Secondary Setting：  Primary
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Start/Frame Trigger 

MG3700A#1 MG3700A#2 

Primary Secondary 

10 MHz buffered output 10 MHz reference input

DUT 

Antenna 1 Antenna 2

 

Figure C.1-4  Multiple MG3700A connection (Primary/Secondary) 

 

Start/Frame Trigger 

< 1 sampling clock 

MG3700A#1 Output 

MG3700A#2 Output 

 

Figure C.1-5  Synchronization relationship of baseband signals 

when using Primary/Secondary 
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C.2 Connecting Multiple MG3710A/MG3740As 
Using external Start/Frame Trigger 

 

In this method, signals are synchronized by supplying an external 
Start/Frame Trigger to multiple MG3710A units. Fig. C.2-1 shows a 
connection diagram. 

 

Start/Frame Trigger

10 MHz buffered output 10 MHz reference input

DUT 

Antenna 1  Antenna 2

MG3710A#1 MG3710A#2 

Pulse Generator (TTL) 

Start/Frame Trigger

 

Figure C.2-1  Multiple MG3710A connection (external Start/Frame Trigger) 

 

Synchronizing baseband signals 

Input a TTL-level pulse signal to the Start/Frame Trigger connector on 
the MG3710A #1 as well as the MG3710A #2. 
Next, configure the settings as follows for these two MG3710A units. 

Start/Frame Trigger: 
Trigger = ON 
Mode = Start 

Synchronization between baseband signals is established within one 
sampling clock of the waveform pattern with Delay = 0 (excluding an 
external cable delay error). Fig. C.2-2 shows the synchronization 
relationship of the two signal generators.  

Note that the delay adjustment resolution changes, depending on the 
sampling rate. Refer to the following manual(s) for details.  

 MG3710A/MG3710E Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 
7.3.8 “Start/Frame Trigger” 
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The MG3710A waits for the trigger to be input once the Waveform 
Restart function key is pressed. Input the trigger after both of the 
MG3710A units are in this state.  

Synchronizing RF signals 

The RF frequencies of the two MG3710A units are synchronized using a 
10 MHz reference clock. 
Modify the Phase Adjust setting of either unit when changing the phase 
relation of the RF signal. 

 

Start/Frame Trigger 

< 1 sampling clock 

MG3710A#1 Output 

MG3710A#2 Output 

 

Figure C.2-2  Synchronization-baseband signals when using external 

Start/Frame Trigger 
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Using Primary/Secondary 

In this method, signals are synchronized by sending a Start/Frame 
Trigger from the Primary to Secondary, where MG3710A#1 is the 
Primary and MG3710A#2 is the Secondary. Primary and Secondary must 
be set when generating waveforms, before the waveform patterns can be 
used, because the waveform pattern that is output from the MG3710A 
set as the Secondary side produces a one frame lag to the Primary side 
when Delay = 0. For the MX370107A on the Primary side, set SG 
Primary/Secondary Setting to Primary and select Pattern Sync Marker 
from Marker 1 to Marker 3, as shown in Fig. C.2-3. For the Secondary 
side, SG Primary/Secondary Setting is automatically set to Secondary. 

 

Figure C.2-3  Setting example of Primary side 

 

Fig. C.2-4 shows the connection, and Fig. C.2-5 shows the 
synchronization relationship of the two signal generators. Compared to 
the method using an external Start/Frame Trigger, the synchronization 
error between the Primary output and Pattern Sync Marker is greater 
when using Primary/Secondary.  

Refer to the following manual(s) for details on the operation when the 
Start/Frame trigger is input.  

 MG3710A/MG3710E Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (Mainframe) 
7.3.8 “Start/Frame Trigger” 

 

 

 

 SG Primary/Secondary Setting：  Primary
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Start/Frame Trigger

MG3710A#1 

Primary 
Secondary 

10 MHz buffered output 10 MHz reference input

DUT 

Antenna 1 Antenna 2

AUX Input/Output 

Connector 1 

MG3710A#2 

 

Figure C.2-4  Multiple MG3710A connection (Primary/Secondary) 

 

 

Start/Frame Trigger 

< 1 sampling clock 

MG3710A#1 Output 

MG3710A#2 Output 

 

Figure C.2-5  Synchronization relationship of baseband signals 

when using Primary/Secondary 
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This appendix provides two fading characteristic examples, the Doppler 
spectrum and an accumulated probability distribution/level crossing rate, 
as the verification results of the waveform data generated by this 
software. 

 

D.1 Doppler Spectrum ......................................................... D-2 
D.2 Accumulated Probability Distribution/  

Level Crossing Rate ..................................................... D-6 
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D.1 Doppler Spectrum 
Figs. D.1-1 to D.1-8 show examples of the spectrum when the Doppler 
spectrum is changed with the fading type Rayleigh and Rice. 

 

Figure D.1-1  Rayleigh with Classical 3 dB 
 

 

Figure D.1-2  Rayleigh with Classical 6 dB 
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Figure D.1-3  Rayleigh with Flat 
 

 

Figure D.1-4  Rayleigh with Rounded 
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Figure D.1-5  Rice with Classical 3 dB 
 

 

Figure D.1-6  Rice with Classical 6 dB 
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Figure D.1-7  Rice with Flat 
 

 

Figure D.1-8  Rice with Rounded 
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D.2 Accumulated Probability Distribution/ 
Level Crossing Rate 

This section describes a calculation example of an accumulated 
probability distribution/level crossing rate when a fading processing is 
performed by the MX370107A on a tone signal waveform pattern with 
the same sampling frequency and length as the MG3700A or MG3710A 
standard waveform pattern UL_RMC_12_2kbps. 
The setting values of the parameters are as shown in table D.2-1. 

Table D.2-1  Accumulated probability distribution/ 
level crossing rate calculation parameters 

System Configuration 
Channel Configuration 1 × 1 SISO 

Tx Antenna Configuration (Tx Antenna 1) 
RF Frequency 2000.00000000 MHz 
Sampling Rate 11.52 MHz 
Repetition 1 
Pattern Length 10220 ms 

Channel Setting (Channel 1) 
Moving Speed 2.3, 50, 120, 250, 583 km/h 

Doppler Frequency 4.262, 92.657, 222.376, 463.283,  
1080.377 Hz 

Round Fading Pattern Clear 
Random Seed 1 

Rx Antenna Configuration (Rx Antenna 1) 
AWGN Clear 

 
Reference 
[1] IEC 60489-6, Annex C (1999) 
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At Moving Speed = 2.3 km/h 
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Figure D.2-1  Accumulated probability distribution (Moving Speed = 2.3 km/h) 
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Figure D.2-2  Level crossing rate (Moving Speed = 2.3 km/h) 
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At Moving Speed = 50 km/h 
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Figure D.2-3  Accumulated probability distribution (Moving Speed = 50 km/h) 
 

1

10

100

1000

-25.5 -23 -20.5 -18 -15.5 -13 -10.5 -8 -5.5 -3 -0.5 2 4.5

Peak Power / Avg. Power (dB)

Le
ve

l C
ro

ss
in

g 
R

at
e 

(ti
m

es
/s

)

Rayleigh Distribution
Rayleigh Distribution (+20% shift)
Rayleigh Distribution (-20% shift)
Moving Speed = 50 (km/h)

 

Figure D.2-4  Level crossing rate (Moving Speed = 50 km/h) 
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At Moving Speed = 120 km/h 
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Figure D.2-5  Accumulated probability distribution (Moving Speed = 120 km/h) 
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Figure D.2-6  Level crossing rate (Moving Speed = 120 km/h) 
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At Moving Speed = 250 km/h 
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Figure D.2-7  Accumulated probability distribution (Moving Speed = 250 km/h) 
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Figure D.2-8  Level crossing rate (Moving Speed = 250 km/h)  
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At Moving Speed = 583 km/h 

0.01

0.1

1

10

100

-32.5 -30 -27.5 -25 -22.5 -20 -17.5 -15 -12.5 -10 -7.5 -5 -2.5 0 2.5 5 7.5

Peak Power / Avg. Power (dB)

P
ro

ba
bi

lit
y 

(%
)

 Rayleigh Distribution 
 Rayleigh Distribution(+2 dB shift) 
 Rayleigh Distribution(-2 dB shift) 
 Moving Speed = 583 (km/h)

 

Figure D.2-9  Accumulated probability distribution (Moving Speed = 583 km/h) 
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Figure D.2-10  Level crossing rate (Moving Speed = 583 km/h) 
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